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Before starting any of the projects in this manual, please visit http://www.learnkey.com/admin/files/word2016.zip
and http://www.learnkey.com/admin/files/word2016_project.zip and download the Word 2016 Project Files that accompany 
this manual (you may need to scroll to the bottom of the page for the link).

The exercises in this manual serve as a companion to LearnKey’s training and are organized by session to match the 
presented concepts. Within each session, exercises are arranged from easiest to most challenging. In the Introduction 
section of each session, you will find outlines of the training and sample lesson plans which will give you an overview of 
the training content and help you to structure your lessons. The following sections are included for each session of training:

Skills Assessment: The skills assessment will help you and your students to gauge their understanding of course 
topics prior to beginning any coursework. Each skill listed is tied directly to an exam objective. Understanding 
where your students feel less confident will aid you in planning and getting the most from the training.

Objective Mapping and Shoot File Links: The objective mapping provides a quick reference as to where 
in the training a specific certification exam objective is covered. The Files column lists the name of the Course 
Support files (Excel spreadsheets, Photoshop files, etc.) that are used and demonstrated during the training.  The 
files will typically have a starting file containing all data necessary to begin the demonstrated skill, as well as a 
completed file which shows the final result. 

Keyboard Shortcuts & Tips: The keyboard shortcuts and tips provide a reference of product-specific keyboard 
shortcuts and helpful hints to make working more efficient.

Short Answer and Matching: The short answer questions facilitate a recall of the basic training concepts to 
further aid in retention of the course topics and information in preparation for the training’s Pre-Assessments, 
Post Tests, and MasterExam. The matching exercise provides additional learning reinforcement of terms and 
concepts found throughout the training in the courses’ glossary.

Projects: The projects in this manual are organized by session to match the concepts presented in the LearnKey 
training. Each project is assigned a difficulty level of either beginner, intermediate, or advanced. Some projects 
will be noted as “beginner-intermediate” or other range. Within each session, projects are arranged from easiest 
to most challenging. Each project includes a description of the task as well as steps required for successful 
completion. Note that the steps may not indicate each required action but will provide the expectation of what 
is required leaving the action to the student. References to the concepts demonstrated in the LearnKey training 
that are required for successful completion of the project are also included. Each project will also indicate the 
files and software used to complete the tasks. Some projects may only include a file named “ProjectTitle_End”. 
Projects only including an end file typically begin with a new file which is indicated in the first step. The 
“ProjectTitle_End” file is included to illustrate a possible correct result. Other projects may include a file named 
“ProjectTitle_Start” or other files. Projects with a “ProjectTitle_Start” file begin with that file instead of a new 
file. “Start” files typically contain data required for the project pre-inserted to focus the project on concepts versus 
data entry. 

Using this Workbook

http://www.learnkey.com/admin/files/word2013.zip
http://www.learnkey.com/admin/files/word2013_project.zip
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LearnKey offers video-based training solutions which are flexible enough to accommodate the private student, as well as 
educational facilities and organizations.

Our course content is presented by top experts in their respective fields and provides clear and comprehensive information. 
The full line of LearnKey products have been extensively reviewed to meet superior standards of quality. The content in our 
courses has also been endorsed by organizations, such as Certiport, CompTIA®, Cisco, and Microsoft. However, it is the 
testimonials given by countless satisfied customers that truly set us apart as leaders in the information training world.

LearnKey experts are highly qualified professionals who offer years of job and project experience in their subjects. Each 
expert has been certified in the highest level available for their field of expertise. This provides the student with the 
knowledge necessary to also obtain top-level certifications in the field of their choice.

Our accomplished instructors have a rich understanding of the content they present. Effective teaching encompasses not 
only presenting the basic principles of a subject, but understanding and appreciating organization, real-world application, 
and links to other related disciplines. Each instructor represents the collective wisdom of their field and within our 
industry.

Our Instructional Technology
Each course is independently created, based on standard objectives provided by the manufacturer for which the course was 
developed.

We ensure that the subject matter is up-to-date and relevant. We examine the needs of each student and create training 
that is both interesting and effective. LearnKey training provides auditory, visual, and kinesthetic learning materials to fit 
diverse learning styles. The following are three levels of implementation:

Standard Training Model
The standard training model allows students to proceed through basic training, building upon  primary knowledge and 
concepts to more advanced application and implementation. In this method, students will use the following toolset:

•	 Pre-assessment: The pre-assessment is used to determine the student’s prior knowledge of the subject matter. It 
will also identify a student’s strengths and weaknesses, allowing the student to focus on the specific subject matter 
he/she needs to improve most. Students should not necessarily expect a passing score on the pre-assessment as it is 
a test of prior knowledge.

•	 Video training session: Each course of training is divided into sessions that are approximately two hours in 
length. Each session is divided into topics and subtopics.

•	 Post test: The post test is used to determine the student’s knowledge gained from interacting with the training. In 
taking the post test, students should not consult the training or any other materials. A passing score is 80 percent 
or higher. If the individual does not pass the post test the first time it is taken, LearnKey would recommend the 
incorporation of external resources, such as the workbook and additional customized instructional material.

Intermediate Training Model
The intermediate training model offers students additional training materials and activities which allows for better 
retention, review, and interaction. This model includes not only the standard model material, but also includes the 
following toolset:

•	 Study guides: Study guides are a list of questions missed which can help students recognize areas of weakness 
and necessary focus. They can be accessed from either the pre-assessment or post test.

Best Practices Using LearnKey’s Online Training
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•	 Labs: Labs are interactive activities that simulate situations presented in the training. Step-by-step instructions 
and live demonstrations are provided.

•	 Workbooks: Workbooks have a variety of activities, such as glossary puzzles, short answer questions, practice 
exams, research topics, and group and individual projects, which allow the student to study and apply concepts 
presented in the training.

Master Training Model
The master training model offers the student an additional opportunity to prepare for certification by further examining 
his/her knowledge. This model includes the materials used in the standard and intermediate models, as well as the 
MasterExam.

•	 MasterExam: The MasterExam draws from a large pool of questions to provide a unique testing experience each 
time it is taken. LearnKey recommends a student take and pass the exam, with a score of 80 percent or higher, 
four times in order to prepare for certification testing. Study guides can also be accessed for the MasterExam.
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Students who are working toward becoming career ready must have a working knowledge of Word 2016. LearnKey Senior Instructor 
Jason Manibog will teach you the basics of the software. From there, you will learn how to create and manage documents, format 
documents, create tables and lists, create and manage references, and insert and format graphic elements. This course will prepare you 
to sit for the Microsoft Word Exam 77-725.

Benefits:
•	     Learn how to create and manage documents
•	     Learn how to format text, paragraphs, and sections
•	     Learn how to create tables and lists
•	     Learn how to create and manage references
•	     Learn how to insert and format graphic elements

Word 2016 Introduction
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Skills Assessment
Instructions: Rate your skills on the following tasks from 1-5 (1 being needs improvement, 5 being excellent).

Skills 1 2 3 4 5
Create a document.

Navigate through a document.

Format a document.

Customize options and views for documents.

Print and save documents.

Insert text and paragraphs.

Format text and paragraphs.

Order and group text and paragraphs.

Create a table.

Modify a table.

Create and modify a list.

Create and manage reference markers.

Create and manage simple references.

Insert graphic elements.

Format graphic elements.

Insert and format SmartArt graphics.
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Word 2016 Time Tables

Session 1 Actual Time
Introduction to Word 2016 00:00:49

Getting Started 00:14:48

Create Documents 00:17:21

Navigate Through Documents 00:09:27

Format Documents 00:28:01

Customize Document Views and Options 00:25:49

Print and Save Documents 00:21:31

Domain 1 Recap 00:01:28

Total Time 01:59:14

Session 2 Actual Time
Insert Text and Paragraphs 00:22:17

Format Text and Paragraphs 00:40:12

Order and Group Text and Paragraphs 00:18:39

Domain 2 Recap 00:02:44

Total Time 01:23:52

Session 3 Actual Time
Create Tables and Lists 00:22:56

Modify a Table 00:22:35

Create and Modify a List 00:20:09

Domain 3 Recap 00:02:10

Total Time 01:07:50

***The actual time is calculated based on how long it will take to simply watch the video files.
***The total training time (including watching the videos, completing the labs, projects, and assessments) may double or even triple the actual time.

Session 4 Actual Time
Create and Manage References 00:28:45

Create and Manage Simple References 00:11:17

Proofing the Document 00:03:30

Domain 4 Recap 00:03:30

Total Time 00:45:50

Session 5 Actual Time
Insert and Format Graphic Elements 00:11:46

Format Graphic Elements 00:26:10

Insert and Format SmartArt Graphics 00:11:43

Domain 5 Recap 00:02:07

Test Taking Tips 00:03:21

Total Time 00:55:07



Session 1
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Session 1 Fill-in-the-Blanks
Instructions: While watching Session 1, fill in the missing words according to the information presented by the 
instructor. [References are found in the brackets.]

Create Documents

1.	 You can create a blank document in Word 2016 under the  tab. [Create a Blank Document]

2.	 Templates in Word 2016 are separated by  . [Create a Document from a Template]

3.	 When you work in Word 2016, a lot of the data you work with may come from different  . 
[Open a PDF in Word]

4.	 The Cut button in Excel is represented by a pair of  . [Insert Text from Other Sources]

Navigating Through Documents

5.	 If a feature has a  , you will be able to see it as you hover over the feature on the ribbon. [Search 
for Text]

6.	 You can insert a hyperlink in Word 2016 quickly by simply typing the address of a  . [Insert 
Hyperlinks]

7.	 Bookmarks in a Word 2016 document are  links within the document. [Create Bookmarks]

8.	 You can navigate a Word 2016 document by  , section, line, bookmark, etc. using the Go To 
feature. [The Go To Feature]

Format Documents

9.	 Before you print a Word 2016 document, know where your  are on the page. [Modify Page Setup]

10.	 A theme is a combination of colors and  in Word 2016. [Apply Document Themes]

11.	 Style sets simply change the  of your data in a Word 2016 document. [Apply Document Style Sets]

12.	 A separate  tab appears when you have a header or footer selected. [Insert Headers and Footers]

13.	 You can add watermarks,  , and page borders to the background of Word 2016 documents. 
[Format Page Background Elements]

Customize Document Views and Options

14.	 The  view is used to show you what a document will look like when it is put on a website. 
[Change Document Views]

15.	 The  zoom feature lets you view a document without having to scroll left or right. [Customize 
Through Zoom Settings]

16.	 Save,  , and Redo are the three default buttons on the Quick Access Toolbar. [Customize the 
Quick Access Toolbar]

17.	 You can split windows in Word 2016 under the  . [Split Windows]

18.	 Document properties are added under the File tab in the  section. [Add Document Properties]

19.	 Paragraph marks show you where  characters are on a Word 2016 document. [Show and Hide 
Formatting Symbols]

Print and Save Documents

20.	 Printer  change depending on the printer you have selected to print your document. [Modify 
Print Settings]



13 | Session 1 Word 2016 Project Workbook

21.	 In addition to saving a document in different formats, you can  documents. [Save Documents in 
Different Formats]

22.	 If you want to print consecutive pages from a Word document, use a  . [Print Documents]

23.	 You may not want to publish a document on the Internet if it has hidden properties or  infor-
mation. [Check for Document Issues]

24.	 An  means a document has objects on it that a user with disabilities will be unable to read. 
[Inspect for Accessibility Issues]

25.	 A compatibility issue refers to  unavailable in earlier versions of the Word application. [Inspect 
for Compatibility Issues]
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Working with Templates
Description:
Word 2016 offers a vast array of pre-formatted sample templates from which you can create your documents. Once a document is cre-
ated from a template, you will want to change the information in the document to make it your own. Part of that process can involve 
inserting information from sources outside of Word, such as text files or Excel files.

After completing this project, you will know how to search for and choose a template on which to base a Word document. You will 
also know how to add information from outside of Word into Word.

Steps for Completion:
1.	 Start a new Word document, using the Banded design or Spec design template (you may have to search for these).
2.	 Change the word, Title, to, Truck Report.
3.	 Change the word, Heading, to, For this Week.
4.	 Place the cursor below the existing text.
5.	 Insert the text from the Truck Needs text file in your student folder.
6.	 Insert the Truck Sales Excel file into your document. Your finished document should resemble this:

7.	 Save this file to your student folder, giving it the file name, Truck Report.

Reference:
LearnKey’s Word 2016 Training, Session 1:

Create Documents: Create a Document from a Template; Insert Text from Other Sources

Project Files: Truck Needs.txt, Truck Sales.xlsx

Difficulty: Beginner 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
1.0 Create and Manage Documents

1.1 Create a document
1.1.2 Create a blank document using a template
1.1.4 Insert text from a file or external source



15 | Session 1 Word 2016 Project Workbook

Importing PDFs
Description: 
With newer versions of Word (including 2016), PDF files can be opened and edited. Most text, formatting, and graphics will import 
cleanly into Word, but you may need to make some changes to text, positions, and formats once the import is complete.

Hyperlinks, which navigate people from your documents to outside areas (such as a website), can easily be added to Word documents, 
including ones which started as PDFs and have been imported into Word. After completing this project, you will know how to import 
PDFs into Word and add hyperlinks to a document. 

Steps for Completion:
1.	 Import the Menus.pdf file into a new Word document.
2.	 If there are blank lines between the logo and the menu, delete enough of the blank lines to fit the document onto one page.
3.	 Place the cursor below the menu.
4.	 Type: We are next to LearnKey.
5.	 Turn the word, LearnKey, into a hyperlink to the www.learnkey.com website. Your file should look like this:

6.	 Save a copy of this file, naming it, New Breakfast Menu. Make sure it saves as a Word document, not a PDF.

Reference:
LearnKey’s Word 2016 Training, Session 1: 

Create Documents: Open a PDF in Word
Navigate Through Documents: Insert Hyperlinks

Difficulty: Beginner Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
1.0 Create and Manage Documents

1.1. Create a document
1.1.3 Open a PDF in word for editing

1.2 Navigate through a document
1.2.2 Insert hyperlinks
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Navigating and Styling a Document
Description: 
As Word documents grow, you may wish to add bookmarks, which are internal links set up in documents to help you and others navi-
gate within documents.

In addition, as a document grows, you may want to change the theme (a set of fonts and colors) and/or the style set (the way in which 
titles, headings, and text are positioned on the page). After completing this project, you will be well aware of when you may use book-
marks, navigation techniques, document themes, and document style sets.

Steps for Completion:
1.	 Open the Animal Farm document from your student folder.
2.	 Click on the Animal Farm text and notice the Title style applied (among the styles on the Home tab).
3.	 Click on the House Pets text and notice the Heading 1 style applied.
4.	 Click in the paragraph below the House Pets heading and notice the Normal style applied.
5.	 Place the cursor just before the word, House, in the House Pets heading.
6.	 Insert a bookmark at that location with the name, House.
7.	 Scroll down to page 2 of the document.
8.	 Use the Go To feature to navigate to the House bookmark you created earlier.
9.	 Experiment with different document themes and then apply one of your choosing.
10.	 Experiment with different document style sets and then apply one of your choosing.
11.	 Save a copy of this file to your student folder, giving the file a name of Animal Farm_Styles.

Reference:
LearnKey’s Word 2016 Training, Session 1: 

Navigate Through Documents: Create Bookmarks; The Go To Feature
Format Documents: Apply Document Themes; Apply Document Style Sets

Difficulty: Beginner Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 15 minutes

Objectives:
1.0 Create and Manage Documents

1.2 Navigate through a document
1.2.3 Create bookmarks
1.2.4 Move to a specific location or object in a document

1.3 Format a document
1.3.2 Apply document themes
1.3.3 Apply document style sets
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Page Setup and Background Elements
Description: 
Depending upon the purpose of your Word documents, you may sometimes want to change the page orientation, size, and/or margins 
to best fit your content onto your pages. You may also want to change page background elements, such as adding borders around pages, 
changing the background color in documents, and adding watermarks. Watermarks are background graphics which display messages 
across a page. A common watermark is the word CONFIDENTIAL, which indicates a document should be treated as confidential.

At the completion of this project, you will know how to determine what header and/or footer information to add to a document, and, 
when necessary, how to add page numbers to a document.

Steps for Completion:
1.	 Open the Animal Farm Pages document from your student folder.
2.	 Change the page orientation to landscape.
3.	 Change the margin setting to narrow (.5 inches around the top, bottom, left, and right).
4.	 Change the page size to legal.
5.	 Change the page orientation back to portrait.
6.	 Change the page size back to letter.
7.	 Add a Box page border to the document, using a color of your choice.
8.	 Change the page color to a shade of light blue.
9.	 Add a watermark to the document. The watermark should have the word DRAFT strewn across the page. The document should resemble 

this:

10.	 Save a copy of the file, naming the file Animal Farm Pages_DRAFT. 

Reference:
LearnKey’s Word 2016 Training, Session 1: 

Format Documents: Modify Page Setup; Format Page Background Elements; Watermarks

Difficulty: Intermediate  Advanced 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
1.0 Create and Manage Documents

1.3 Format a document
1.3.1 Modify page setup
1.3.6 Format page background elements
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Inserting Headers, Footers, and Page Numbers
Description: 
Headers and footers are a great way to add information to a document to benefit the reader. In headers and footers, you will often see 
document titles, company names, file names, file paths, the date the document was created, and page numbers.

At the completion of this project, you will know how to determine what header and/or footer information to add to a document, and, 
when necessary, how to add page numbers to a document.

Steps for Completion:
1.	 Open the Animal Farm Headers document from your student 

folder.
2.	 On the second page of the document, insert a header with the 

text, Animal Farm Report, and the current date, set to update 
automatically. Where you position these is up to you.

3.	 Make sure the header does not display on the first page of the 
document.

4.	 Close the header and footer.
5.	 Insert the page number to the bottom center area of the page, 

again making sure the page number does not display on the first 
page of the document. The second page of the document should 
actually indicate it is page 1.

6.	 Reopen the header and footer.
7.	 In the footer, add the file name (Hint: The button used to do 

this is near the same button you used to insert the date). Again, 
make sure the footer does not display on the first page of the 
document.

8.	 Close the header and footer. The second page of your document 
should look similar to the page on the right:

9.	 Save a copy of this file with the name, Animal Farm Headers_
Footers.

Reference:
LearnKey’s Word 2016 Training, Session 1: 

Format Documents: Insert Headers and Footers; Insert Page      
Numbers

Difficulty: Advanced 

Required Materials: Word 2016 

Estimated Time to Complete: 15 minutes

Objectives:
1.0 Create and Manage Documents

1.3 Format a document
1.3.4 Insert headers and footers
1.3.5 Insert page numbers
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Using Different Document Views
Description: 
As you build Word documents, you may want to see how your document will look in ways other than the standard Print Layout view. 
You may want the Read Mode view, which allows you to read but not change your document if you are trying to avoid accidental 
changes to your document. Or, you may want the Web Layout view, which will show you what your document will look like should 
you save it as a webpage.

You may also need to see two parts of your document which are far apart from each other, like the title on the first page and then an 
important paragraph several pages down. For that, you can use the Split view. Finally, you can zoom in and out of parts of your docu-
ment at any time.

After completing this project, you will gain knowledge of the different ways to view Word documents. You will also know how to 
zoom a document in or out to the percentage needed depending upon what you are trying to view.

Steps for Completion:
1.	 Open the Marketing Plan Start file from your 

student folder.
2.	 Change the view to Read Mode. Notice that 

you will not be able to make changes to your 
document.

3.	 Return to the Print Layout view (Hint: Look 
for the menu option which allows you to edit 
the document).

4.	 Change the view to Web Layout view. Notice 
that the page margins disappear.

5.	 Change the view to Outline view. Notice that 
your document looks more like an outline.

6.	 Change the view to Draft view. Notice that the 
logo on page 1 is now hidden.

7.	 Return to the Print Layout view.
8.	 Using the View tab on the ribbon, zoom the 

page out so the width of the page just fits on 
the screen.

9.	 Zoom the view out to where you can see two 
pages at once.

10.	 Set the zoom to 100%. If necessary, scroll back 
to the top of the document

11.	 Split the view into two windows. 
12.	 In the bottom half of the split, scroll down to 

page 3. Your screen should resemble the screen 
on the right:

13.	 Remove the split.
14.	 Using the Options dialog box, show just the 

paragraph marks as nonprinting characters, not 
the spaces or the tabs.

15.	 If you are doing the next workbook project 
right away, leave this file open. Otherwise, close 
the file. You do not need to save the changes.

Reference:
LearnKey’s Word 2016 Training, Session 1: 

Customize Document Views and Options: Change Document Views; Customize through Zoom Settings; Split Windows

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
1.0 Create and Manage Documents

1.4 Customize options and views for documents
1.4.1 Change document views
1.4.2 Customize views by using zoom settings
1.4.4. Split the window
1.4.6 Show or hide formatting symbols
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Creating a Word Project
Description:
Word 2016 has many features to assist you in creating documents quickly and easily. For this project, you will use the information 
learned while watching Session 1 of this course to demonstrate familiarity with these features. Upon completing this project, you will 
know how to create blank documents, enter text, search for text, customize the Quick Access Toolbar, add document properties, and 
work with formatting symbols.

Steps for Completion:
1.	 Launch Word 2016, and open a new blank document. Type a short report (two to three paragraphs) about your favorite book or movie, or 

as otherwise directed by your instructor.
2.	 Identify the Quick Access Toolbar and add the Print Preview and Print button to the toolbar.
3.	 Spend some time customizing the Quick Access Toolbar by adding or removing other options as desired.
4.	 Click the Show/Hide Paragraph Marks button to show spaces and paragraph marks in what you have typed.
5.	 Click the Show/Hide Paragraph Marks button again to hide the spaces and paragraph marks.
6.	 Return to the top of your document and type a title for your document, making sure to leave at least one line space between the title and 

the rest of your text.
7.	 Open the Navigation pane and use it to search for words in your document.
8.	 Save your document as a Word document titled INTERFACE_(your name). Your instructor will tell you where to save your work.
9.	 In the file properties area, add yourself as an author and the word, Interface, as a tag.
10.	 Set the value of the Departments property to the Sales department.
11.	 Save your changes.

Reference:
LearnKey’s Word 2016 Training, Session 1:

Getting Started: Tour of Word
Create Documents: Create a Blank Document
Navigate Through Documents: Search for Text
Customize Document Views and Options: Customize the Quick Access Toolbar; Add Document Properties; Show and Hide Formatting Symbols

Project Files: N/A

Difficulty: Beginner 

Required Materials: Word 2016 

Estimated Time to Complete: 15 minutes

Objectives:
1.0 Create and Manage Documents

1.1 Create a document
1.1.1 Create a blank document

1.2 Navigate through a document
1.2.1 Search for text

1.4 Customize options and views for documents
1.4.3 Customize the Quick Access Toolbar
1.4.5 Add document properties
1.4.6 Show or hide formatting symbols
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Printing and Saving Documents
Description: 
As you work on a Word file, you should be saving the file frequently, especially after you make important changes you absolutely wish 
to keep. At some point, you may need to print a document. You may also need to send it to someone who either does not have Word or 
is not comfortable with using Word. In this project, you will explore printing options and save a document as a PDF file. After com-
pleting this project, you will know how to control print options and save documents in formats other than Word. Note that you will 
not actually be printing the document.

Steps for Completion:
1.	 Open the Marketing Plan Start file from your student folder (if you are doing this right after the previous project, this file should still be 

open).
2.	 Access the Print Preview screen within the Backstage view.
3.	 If you have access to multiple printers, change the printer to which the document is set to print to a different printer.
4.	 Using the Settings area, change the margins from Normal to Moderate.
5.	 Set the document to only print the first two pages. Verify that setting in the Print Preview area (you should only be able to scroll through 

two pages).
6.	 Set the document to print pages 1 and 3. Again, verify that setting in the Print Preview area.
7.	 Set the document to print all pages.
8.	 Save the document as a PDF to your start folder, giving the PDF the name, Marketing Plan. If you have a PDF reader installed, you can 

set the option for opening the file after publishing it if you so choose.
9.	 If you are continuing with the next workbook project, leave the file open. Otherwise, close the file. You do not need to save changes to the 

file.

Reference:
LearnKey’s Word 2016 Training, Session 1 

Print and Save Documents: Modify Print Settings; Save Documents in Different Formats; Print Documents

Difficulty: Beginner 

Required Materials: Word 2016 

Estimated Time to Complete: 15 minutes

Objectives:
1.0 Create and Manage Documents

1.5 Print and save documents
1.5.1 Modify print settings
1.5.2 Save documents in alternative file formats
1.5.3 Print all or part of a document
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Inspecting a Document
Description: 
Before a Word document is distributed, especially if it is going to be distributed to a wide audience, the document should be put 
through inspection. There are three types of inspections: checking for hidden and/or personal information, checking for accessibility 
issues, and checking for compatibility issues.

Accessibility issues affect those who need assistance to view a document, such as those who are vision-impaired and use voice readers 
to read documents. Compatibility issues affect those who view documents in earlier versions of Word. After completing this project, 
you will know how to check for these issues and then decide whether these issues are worth fixing.

Steps for Completion:
1.	 If you are continuing from the previous exercise, you should have the Marketing Plan Start file open. Otherwise, open the Marketing Plan 

Start file from your student folder.
2.	 Inspect the document for hidden and personal information. 
3.	 From the Document Inspector dialog box, remove the document properties and personal information from the document.
4.	 Check the document for accessibility issues.
5.	 When the inspection results appear, click the Table Column or Table Row link under the Blank Table Rows or Columns warning. 
6.	 Notice that the table indeed has empty cells, but that is fine for now as this document is not yet complete.
7.	 Inspect the document for compatibility issues. Take note of the compatibility issues listed.
8.	 Save a copy of the file, naming the file, Marketing Plan_Inspected.
9.	 Close all open Word files.

Reference:
LearnKey’s Word 2016 Training, Session 1: 

Print and Save Documents: Check for Document Issues; Inspect for Accessibility Issues; Inspect for Compatibility Issues

Difficulty: Advanced 

Required Materials: Word 2016 

Estimated Time to Complete: 10 minutes

Objectives:
1.0 Create and Manage Documents

1.5 Print and save documents
1.5.4 Inspect a document for hidden properties or personal information
1.5.5 Inspect a document for accessibility issues
1.5.6 Inspect a document for compatibility issues



Session 2
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Session 2 Fill-in-the-Blanks
Instructions: While watching Session 2, fill in the missing words according to the information presented by the 
instructor. [References are found in the brackets.]

Insert Text and Paragraphs

1.	 You can find and replace text in Word 2016 under the Home tab in the  group. [Find and Re-
place Text]

2.	 You can quickly select an entire paragraph in Word 2016 by  . [Cut and Paste Text]

3.	 The AutoCorrect feature will fix some  issues immediately. [Use AutoCorrect to Replace Text]

4.	 By default, the AutoCorrect feature will capitalize the  letter of sentences. [Use AutoCorrect to 
Replace Text]

5.	 You can find a number of symbols under the Insert tab and the Symbols drop-down menu under 

 . [Insert Symbols]

6.	 Special characters can be inserted into a Word 2016 document using  . [Insert Special Characters]

7.	 The Undo and Redo features can be found on the  . [Use Undo and Redo]

Format Text and Paragraphs

8.	 The  , Italics, and Underline features are on/off buttons in Word 2016. [Apply Font Formatting]

9.	 The Format Painter is useful if you do not  what formats you used in a Word 2016 document. 
[Use the Format Painter]

10.	 Line and paragraph spacing can be configured on the ribbon under the  tab. [Set Line and Para-
graph Spacing]

11.	 You can use paragraph  to see if paragraph spacing is currently in use. [Set Line and Paragraph 
Spacing]

12.	 You can use the  Indent and Decrease Indent buttons to affect the indentation of your para-
graphs. [Set Line and Paragraph Indentation]

13.	 Tabs are easier to use in Word 2016 than normal  when trying to line up data. [Set Tabs]

14.	 You can set tabs more accurately in Word 2016 from the  dialog box launcher. [Set Tabs]

15.	 The Clear button is represented by an  . [Clear Formatting]

16.	 You can quickly highlight text using a different color by  a selection of text. [Use the Text High-
lighter]

17.	 The Style group can be found in the  tab. [Apply Built-In Styles]

18.	 WordArt in Word 2016 is essentially  that is acts like an image. [Change Text to WordArt]

Order and Group Text and Paragraphs

19.	 You can add columns to data in Word 2016 under the  tab under Columns. [Format Text in 
Multiple Columns]

20.	 It is important to pay attention to what you are doing to your  in the Columns dialog box. 
[Format Text in Multiple Columns]

21.	 Page breaks make it possible for you to determine where you stop  on one page and begin on 
another page. [Insert Page Breaks]

22.	 Section breaks allow you to have separate  for different sections of your document. [Insert Sec-
tion Breaks]
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23.	 A column break simply moves data from one area of your document into a  . [Insert Column 
Breaks]

24.	 When you alter the  of a document, pay attention to what area of the document you are ap-
plying the changes to. [Set Page Setup Options in a Section]
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Inserting Text and Paragraphs
Description: 
Whether you build Word documents from scratch, add to existing documents, or do both, you will undoubtedly need to replace certain 
words or phrases in your documents. You may also need to move and/or copy text from one place to another.

In addition, as you type text, Word is smart enough to know we are not perfect typists, and thus the AutoCorrect feature will correct 
our most common errors, such as capitalizing the first two letters of a sentence, not capitalizing the first letter of a sentence, and typical 
typographical errors, such as replacing teh with the.

Finally, you may need to insert symbols or special characters into a document. One example of this is the copyright symbol. After 
completing the following project, you will be better equipped to replace text, cut and paste text, copy and paste text, use AutoCorrect, 
and insert symbols as needed.
Steps for Completion:

1.	 From your student folder, open the AUP Revised file.
2.	 Replace every instance of the text, <Company Name>, 

with your own company name.
3.	 Replace every instance of the text, <Company>, with 

the same company name you used in the previous step.
4.	 Find the text, 4.3.2 Email and Communication 

Activities.
5.	 Inside the Email and Communication Activities 

section, cut the text for item number 2 and paste 
it before item number 1. The numbers will update 
automatically.

6.	 Inside the same section, copy the text for item number 
7 and paste it right below the existing item.

7.	 In the new copy of the item, change the word, Usenet, 
to the word, other. Your Email and Communication 
Activities section should look like the example on the 
right (with your company name, of course):

8.	 Scroll down to the end of the document and place 
the cursor at the very end of the document, below the 
revision history table.

9.	 Type: EMployee and press the Space bar. Notice that 
the word AutoCorrects to the word Employee.

10.	 Type: Signature
11.	 Press the Space bar and then insert a symbol for a 

hand signing a paper (Hint: You can use either symbol 63 or symbol 64 in the Wingdings font). The end of your document should look 
like this:

12.	 Save a copy of the document with the name, AUP Rev3.

Reference:
LearnKey’s Word 2016 Training, Session 2: 

Insert Text and Paragraphs: Find and Replace Text; Cut and Paste Text; Copy and Paste Text; Use AutoCorrect to Replace Text; Insert Symbols; 
Insert Special Characters

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 20 minutes

Objectives:
2.0 Format Text, Paragraphs, and Sections

2.1 Insert text and paragraphs
2.1.1 Find and replace text
2.1.2 Cut, copy, and paste text
2.1.3 Replace text by using AutoCorrect
2.1.4 Insert special characters
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Formatting Text and Paragraphs
Description: 
Understanding basic formatting features found in Word 2016 is an important part of producing a professional and attractive docu-
ment. Text can be formatted to your font, size, color, and effects of choice. Using the Format Painter to copy a format from one block 
of text to another as well as the Clear All Formatting button to clear any applied formatting are quick methods used to control the 
formatting of specific blocks of text. 

For paragraphs, two important formatting aspects are indenting and line spacing. After completing this project, you will know how to 
do these two formatting functions in addition to applying font, size, color, and effects to text.

Steps for Completion:
1.	 Open the Animal Types document from your student folder.
2.	 Format the Animal Types heading to a font of your choice, size 16 points, bold, and to a different color.
3.	 With the Animal Types heading, expand the spacing by 1 point (Hint: that option will not be directly on the ribbon).
4.	 Format the word, Mammals, to a size of 12 points, bold, and a different color.
5.	 Using the Format Painter, apply the same format you just applied on the word Mammals to the other paragraph headings (Birds, Fish, 

Reptiles, Amphibians, Arthropods, Diets, and Reference).
6.	 Clear the formatting on the paragraph below the Arthropods heading.
7.	 Under the Diets heading, indent the five diets .5 inches.
8.	 In the paragraph under the Fish heading, apply a line spacing of 1.0.
9.	 Apply the same line spacing (1.0) to the paragraph under the Amphibians heading.
10.	 For the entire document, change the spacing after each paragraph to 3 points. The document should now fit on one page and look similar 

to this:

11.	 Save a copy of the document with the name, Animal Types_Formatted.

Reference:
LearnKey’s Word 2016 Training, Session 2 

Format Text and Paragraphs: Apply Font Formatting; Use the Format Painter; Set Line and Paragraph Spacing; Set Line and Paragraph Indenta-
tion; Clear Formatting

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 15-20 minutes

Objectives:
2.0 Format Text, Paragraphs, and Sections

2.2 Format text and paragraphs
2.2.1 Apply font formatting
2.2.2 Apply formatting by using the Format Painter
2.2.3 Set line and paragraph spacing and indentation
2.2.4 Clear formatting
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Highlights, Styles, and WordArt
Description: 
Basic formatting involves changing fonts, colors, and font sizes on text and controlling line and paragraph spacing. Additional format-
ting options include using the highlighter pen to highlight text, apply pre-built styles to text (especially headings), and apply WordArt 
effects to text. WordArt is a formatting tool which adds effects such as color, outlines, shadows, glows, and bevel to text.

Upon completing this project, you will be familiar with the highlighter pen, built-in styles, and the concept of WordArt.

Steps for Completion:
1.	 From your student folder, open the Animal Types Styles file.
2.	 Apply a pink highlighter pen to the text, People are mammals, located under the Mammals heading.
3.	 Apply the Heading 2 style to the following headings: Mammals, Birds, Fish, Reptiles, Amphibians, Arthropods, Diets, and Reference.
4.	 Apply the Gradient Fill – Purple, Accent 4, Outline – Accent 4 WordArt effect to the Animal Types heading at the top of the page. The 

first part of your document should resemble this:

5.	 Save a copy of the file, naming the file, Animal Types Styles_WordArt.

Reference:
LearnKey’s Word 2016 Training, Session 2: 

Format Text and Paragraphs: Use the Text Highlighter; Apply Built-In Styles; Change Text to WordArt

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10 minutes

Objectives:
2.0 Format Text, Paragraphs, and Sections

2.2 Format text and paragraphs
2.2.5 Apply a text highlight color to text selections
2.2.6 Apply built-in styles to text
2.2.7 Change text to WordArt
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Ordering and Grouping Text and Paragraphs
Description: 
Some Word documents will contain text that appears in lists or needs to be displayed in columns, such as that of a newsletter. To better 
lay out a document, breaks can be inserted, such as page breaks, to ensure content blocks start on a new page, if desired. Section breaks 
can be inserted so that, for example, one part of a document can use a portrait orientation while another part of a document can use a 
landscape orientation. Column breaks can be inserted so that a column heading can be moved to the top of a column.

After completing this project, you will know how to break text into columns, insert page, section, and column breaks, and change the 
page setup for a specific section of a document.

Steps for Completion:
1.	 From your student folder, open the Recipe document.
2.	 If the paragraph marks are not displaying, display the paragraph marks.
3.	 Select the Ingredients heading and the subsequent text for all of the ingredients.
4.	 Break the ingredients text into two columns, noticing that section breaks are also inserted before and after the text.
5.	 Insert a column break before the text, 1/2 cup white sugar.
6.	 Insert a page break before the Steps heading.
7.	 Insert a next page section break just before the picture, so that the picture is on its own page, in its own section.
8.	 Change just the section containing the cookie to a landscape page orientation.
9.	 Save a copy of the document with the name, Recipe_Sections.

Reference:
LearnKey’s Word 2016 Training, Session 2: 

Order and Group Text and Paragraphs: Format Text in Multiple Columns; Insert Page Breaks; Insert Section Breaks; Insert Column Breaks; Set 
Page Setup Options in a Section.

Difficulty: Advanced 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
2.0 Format Text, Paragraphs, and Sections

2.3 Order and group text and paragraphs
2.3.1 Format text in multiple columns
2.3.2 Insert page, section, or column breaks
2.3.3 Change page setup options for a section
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Session 3
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Session 3 Fill-in-the-Blanks
Instructions: While watching Session 3, fill in the missing words according to the information presented by the 
instructor. [References are found in the brackets.]

Create Tables and Lists

1.	 Tables allow you to store information in  and columns. [Create a Table]
2.	 The key to creating a table from existing data in Word 2016 is to have consistently laid out information with a consistent 

 in between. [Convert Text to Tables]

3.	 You can select an entire column in a table by moving your mouse over the column until a  ap-
pears. [Convert Text to Tables]

4.	 The Convert to Text button on the ribbon is hidden in the Layout tab under  . [Convert Tables to 
Text]

5.	 It is relatively easier to add  to a table than it is to add . [Create a Table with Specific Options]

6.	 The  key can be used to quickly navigate inside a table. [Create a Table with Specific Options]

7.	 A separate Design tab and Layout tab appears under  on the ribbon when the cursor is acti-
vated inside of a table. [Apply Table Styles]

8.	 The  and  settings affect whether every other column or row is 
highlighted. [Set Table Style Options]

9.	 You can change the settings of a specific table style by clicking  . [Set Table Style Options]

Modify a Table

10.	 You can sort data in a table under the separate  by clicking Data, and then Sort. [Sort Table Data]

11.	 Cell margins refer to the spacing  of a cell. [Cell Margins and Spacing]

12.	 The keyboard shortcut used to paste data is  . [Merge and Split Cells]

13.	 You can resize a table by clicking and dragging the lower  corner of the table. [Resize Tables]

14.	 You can manually resize a table under the separate table Layout tab, by clicking  . [Resize Rows 
and Columns]

15.	 Under the separate table Layout tab, you can click  to separate the active table. [Split Tables]

16.	 You can change the alignment of a table under the  of the Table Properties dialog box. [Config-
ure a Repeating Row Header]

Create and Modify a List

17.	 Word 2016 will by default automatically number a list if you type a number followed by a  
and a space. [Create a Numbered List]

18.	 A bulleted list is useful if the  of the list does not matter. [Create a Bulleted List]

19.	 If you highlight a numbered list and the numbers can be highlighted, the list was typed in  . 
[Change Number Formats]

20.	 You can change bullet characters by clicking the  next to the Bullets button. [Change Bullet 
Characters]

21.	  and pictures can be used to customize bullet characters. [Customize Bullet Characters]
22.	 When customizing a number format, leave the automatic numbering part alone. It is highlighted in 

 . [Customize Number Formats]

23.	 You can use the  key to add indents and subtopics to a numbered list. [Increase or Decrease List 
Levels]
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24.	  the numbers in a numbered list to control the list numbering. [Control List Numbering]
25.	 You can set a starting number value for a numbered list by clicking the drop-down arrow next to the 

 button on the Home tab. [Set Starting Number Value]
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Converting Text to Tables and Tables to Text
Description: 
Rather than build tables from scratch, text with a common separator (such as a tab or comma) can be converted to a well-organized 
table. On the other hand, information in a table may look better if organized in tabs instead of in a table.

After completing this project, you will know how to convert text to a table and how to convert a table back to text.

Steps for Completion:
1.	 From your student folder, open the Information Please file.
2.	 To best see how the information was entered into the document, make sure the paragraph marks are turned on.
3.	 Convert the three lines of text under the Types of Parks heading into a table, using the AutoFit to Contents option. Your content should 

look like this:

4.	 Convert the table under the Types of Museums heading to text, separating the text with tabs. Your converted text should look like this:

5.	 Save a copy of the file with the file name, Information Please_Converted.
6.	 If desired, hide the paragraph marks.

Reference:
LearnKey’s Word 2016 Training, Session 3: 

Create Tables and Lists; Convert Text to Tables; Convert Tables to Text

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10 minutes

Objectives:
3.0 Create Tables and Lists

3.1 Create a table
3.1.1 Convert text to tables
3.1.2 Convert tables to text
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Creating and Styling Tables
Description: 
While some tables will be built from existing text, most tables need to be created from scratch. The most important factor for building 
tables is knowing the number of rows and columns (especially columns) needed for the table.

Once a table is created and data has been entered, one may want to style the table using a number of pre-built formats, including 
colors and styles for the overall table, headers, rows, and columns. Upon completing this project, you will know how to create a table 
through specifying the number of rows and columns, add data to a table, and apply styles to a table.

Steps for Completion:
1.	 From your student folder, open the Information Tables document.
2.	 Scroll down to the Types of Transportation heading.
3.	 Below the Types of Transportation heading, insert a table containing four rows and three columns.
4.	 Enter the following information into the table:

Type Cost Availability
Taxi $20 High
Limo $70 Low
Rental Car $100 Medium

5.	 Apply the Grid Table 2 – Accent 5 style to the table.
6.	 Make sure the following table style options are applied: Header Row, First Column, and Banded Columns. Ensure no other table style 

options are applied. Your finished table should look like this:

7.	 Save a copy of the file with the name, Information Tables_Transportation.

Reference:
LearnKey’s Word 2016 Training, Session 3: 

Create Tables and Lists: Create a Table with Specific Options; Apply Table Styles; Set Table Style Options

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
3.0 Create Tables and Lists

3.1 Create a table
3.1.3 Create a table by specifying rows and columns
3.1.4 Apply table styles
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Sorting Information and Formatting Table Cells
Description: 
Once a table is created and information is entered, one may want to sort the information alphabetically, numerically, or by date. Infor-
mation in one table cell may need to be split into multiple cells, as is the case with a cell containing a lot of detailed information. Or, 
the opposite may be true, in which a row of cells should be merged into a single cell.

To control the appearance of table cells, margins within the cells and spacing between cells can also be adjusted. After completing this 
project, you will know when and how to sort table information, merge cells, split cells, and control margins within cells and spacing 
between cells.

Steps for Completion:
1.	 From your student folder, open the Information Tables Unsorted document.
2.	 Sort the information in the Types of Animals table alphabetically by animal type (the left column), making sure no header rows are 

indicated.
3.	 In the Types of Animals table, set the cell margins to be .1 inches for all four sides of the cells.
4.	 In the Types of Animals table, set the cell spacing to be .1 inches. The top of the table should look like this:

5.	 In the Types of Parks table, split the last row into two cells.
6.	 In the newly split row, move the text after the first instance of the word, Golf, into the cell on the right. The table should look like this:

7.	 In the Types of Transportation table, merge the cells in the last row. The table should look like this:

8.	 Save a copy of this file with the name, Information Tables Sorted.

Reference:
LearnKey’s Word 2016 Training, Session 3: 

Modify a Table: Sort Table Data; Cell Margins and Spacing; Merge and Split Cells

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 15 minutes

Objectives:
3.0 Create Tables and Lists

3.2 Modify a Table
3.2.1 Sort table data
3.2.2 Configure cell margins and spacing
3.2.3 Merge and split cells
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Modifying Tables
Description: 
As tables are built, filled with information, and configured for cell margins, spacing, and merging or splitting cells, other formatting 
options can be applied to these tables. These include resizing entire tables or just table rows and/or columns. If a table is portraying 
information on multiple categories, it can be split into two tables. And, should tables display across multiple pages, the top row or rows 
should be set to repeat at the top of each page, so that those viewing tables on multiple pages know what each column represents.

After completing this project, you will have a better understanding of how to resize tables, rows, and columns. You will also have a bet-
ter understanding of how to split tables and configure part of a table to repeat across pages.

Steps for Completion:
1.	 From your student folder, open the Information Updates file.
2.	 Resize the table under the Types of Parks heading to be 5 inches wide.
3.	 Resize all of the rows of the table to be .4 inches tall.
4.	 Set the column widths of the table to be equally distributed, that is, each column is the same width.
5.	 Split the Types of Parks table into two tables, with each table containing two rows.
6.	 Add the heading, Types of Sports Fields, above the second table resulting from the table split.
7.	 Apply the Heading 1 style to the new heading, Types of Sports Fields. The top of your document should look like this:

8.	 Scroll down to the Types of Transportation table.
9.	 Set the top row of the Types of Transportation table to repeat as a header row at the top of each page. 
10.	 Save a copy of the file with the name, Information Updates_Applied.

Reference:
LearnKey’s Word 2016 Training, Session 3: 

Modify a Table: Resize Tables; Resize Rows and Columns; Split Tables; Configure a Repeating Row Header

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 15 minutes

Objectives:
3.0 Create Tables and Lists

3.2 Modify a table
3.2.4 Resize tables, rows, and columns
3.2.5 Split tables
3.2.6 Configure a repeating row header
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Creating and Modifying Bulleted Lists
Description: 
Bulleted lists are normally used to display information in a list format, with emphasis on the list items. Bulleted lists are best used 
when emphasis is needed but the order of importance in the list items does not matter much, if at all. For list items to where the order 
of importance matters, a numbered list should be used. Bulleted lists can be formatted in many different ways, such as by bullet type 
and indentation, and at the end of this project, you will have a better understanding of these formats and of how to create bulleted lists.

Steps for Completion:
1.	 From your student folder, open the Vision and Mission Statement file.
2.	 Select the text starting with the second line under the Objectives heading, all the way down through the remaining indented lines, ending 

with, …Houston, TX area.
3.	 Turn the selected text into a bulleted list, using the default bullet symbol.
4.	 Change the bullets from dots to squares, using the available bullet options.
5.	 Select the three bulleted states (Texas, New Mexico, and Arizona).
6.	 Indent the three bulleted states.
7.	 Change the bullet on the three states to a bell symbol, using the Wingdings font. Your bulleted list should resemble this:

8.	 Save a copy of the file with the name, Vision and Mission Statement Bulleted.
9.	 If you are continuing to the next project, leave this file open as you will be using it in the next project.

Reference:
LearnKey’s Word 2016 Training, Session 3: 

Create and Modify a List: Create a Bulleted List; Change Bullet Characters; Customize Bullet Characters; Increase or Decrease List Levels

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
3.0 Create Tables and Lists

3.3 Create and modify a list
3.3.1 Create a numbered or bulleted list
3.3.2 Change bullet characters or number formats for a list level
3.3.3 Define a custom bullet character or number format
3.3.4 Increase or decrease list levels
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Creating and Modifying Numbered Lists
Description: 
Whereas a bulleted list is helpful for identifying list items without a need for order, a numbered list is best suited for list items which 
need to be ordered, such as the case, for example, with a list of steps which need to be followed in order to complete a process.

With numbered lists, numbered formats can be changed and list numbering can be controlled. At the completion of this project, you 
will have good conceptual knowledge of building and formatting numbered lists.

Steps for Completion:
1.	 If you just completed the previous project, use the Vision and Mission Statement Bulleted file from your student folder. If not, open the 

Vision and Mission Statement with Bullets file from your student folder.
2.	 Select the first five cities under the Market Expansion heading.
3.	 Create a numbered list from the five cities you selected.
4.	 Select the four cities under the, Then, we will want to branch out…, sentence.
5.	 With the selected cities, create another numbered list.
6.	 Set the format of the first numbered list to a 1) format instead of a 1. format.
7.	 Set the second numbered list to continue numbering from the previous list. Your two numbered lists should look like this:

8.	 Scroll up to the Objectives section.
9.	 Change the three states (Texas, New Mexico, and Arizona) to a numbered list, using the A. B. C. format.
10.	 Set the list to start with the letter C instead of the letter A. Your state list should look like this:

11.	 Save a copy of the file with the name, Vision and Mission Statement with Numbers.
12.	 Close all of your open files.

Reference:
LearnKey’s Word 2016 Training, Session 3: 

Create and Modify a List: Create a Numbered List; Change Number Formats; Customize Number Formats; Control List Numbering; Set Starting 
Number Value

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 15-20 minutes

Objectives:
3.0 Create Tables and Lists

3.3 Create and modify a list
3.3.1 Create a numbered or bulleted list
3.3.2 Change bullet characters or number formats for a list level
3.3.3 Define a custom bullet character or number format
3.3.4 Increase or decrease list levels
3.3.5 Restart or continue list numbering
3.3.6 Set starting number value
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Session 4
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Session 4 Fill-in-the-Blanks
Instructions: While watching Session 4, fill in the missing words according to the information presented by the 
instructor. [References are found in the brackets.]

Create and Manage References

1.	 References are important if you build a lot of  . [Create and Manage Reference Markers]

2.	 By default, a footnote appears at the  of each page. [Insert Footnotes]

3.	 An  only appears at the end of the entire document. [Insert Footnotes]

4.	 Footnotes do not  themselves back to one if you go to another page. [Insert Footnotes]

5.	 Under the References tab, you can click  to display what endnotes and footnotes you have 
added to a document. [Insert Endnotes]

6.	 You can change the properties of your footnotes and endnotes by opening the Footnotes  . 
[Modify Footnote Properties]

7.	 Endnotes can come at the end of a document or at the end of a  . [Modify Endnote Properties]

8.	 Citation sources can come from  , websites, or audio files. [Create Bibliography Citation Sources]
9.	 On the ribbon, you can configure citations under the References tab, in the Citations & Bibliography group, by clicking 

 . [Create Bibliography Citation Sources]

10.	 You will have a different set of text  to fill out depending on the type of source you are citing. 
[Create Bibliography Citation Sources]

11.	 When you edit a source, you will be asked if you want to update the source in the  list and the 
current document. [Modify Bibliography Citation Sources]

12.	 A  simply reminds you to enter a source before you publish a document. [Insert Citations for 
Bibliographies]

13.	 If text is automated in a document, the text will be highlighted  as you hover over it. [Insert 
Citations for Bibliographies]

14.	 Captions can be inserted into a document from the  tab. [Insert Figure Captions]

15.	 If you are adding a caption to a table, you will want to change the  from figure to table. [Insert 
Table Captions]

16.	 Inserting a new caption on top of an existing caption does not  the original caption. [Modify 
Caption Properties]

17.	 Under the  tab, you can add a table of figures from the Captions group. [Modify Caption Proper-
ties]

18.	 References and citations have  that you can change. [Modify Caption Properties]

Create and Manage Simple References

19.	 Word 2016 has automated features to help you create a table of contents, a  , and proofread 
the content of a document. [Insert a Table of Contents]

20.	 In order for a table of contents to generate properly, you must utilize  in your document. [Insert 
a Table of Contents]

21.	 You can create a table of contents automatically under the  tab of the ribbon. [Insert a Table of 
Contents]

22.	 You can quickly navigate to areas of your document by holding  and clicking items on the 
table of contents. [Update a Table of Contents]

23.	 You can insert a cover page from the ribbon under the Insert tab by clicking the  drop-down 
menu and clicking Cover Page. [Insert a Cover Page]
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Proofing the Document

24.	 Reading a document  or having another person read the document are good ways to proofread 
a document. [Check Spelling and Grammar]

25.	 You can perform a spell check on a document by clicking the  tab and clicking Spelling & 
Grammar. [Check Spelling and Grammar]
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Footnotes and Endnotes
Description: 
One way in which a source of information can be cited is to add a footnote to the bottom of the page on which the information is 
located. For example, a Word document may have a quote from someone. A footnote can be used to reveal the source of a quote.

Another option for citations is that of endnotes. Endnotes are similar to footnotes but appear at the end of a document instead at the 
bottom of a page. Though footnotes and endnotes have default numbering and locations, these can be changed and upon completing 
this project, you will know how to add footnotes and endnotes and you will be able to modify footnote and endnote properties. 

Steps for Completion:
1.	 From your student folder, open the Weather Report document.
2.	 On page 1, add a footnote at the end of the first paragraph of the Warm and Cold Winter States heading. The footnote text should be, 

This is according to numerous online sources.
3.	 On page 2, add a footnote to the end of the text, …winter temperatures for Western states:, with the text, Averages combined from many 

weather data reports.
4.	 On page 3, add an endnote to the text, …average of 30 degrees Fahrenheit in higher elevations, with the text, But the average is higher in 

lower elevations.
5.	 On page 4, add an endnote to the text, …974.5 inches in Thompson Pass, with the text, Barrow is the northernmost city.
6.	 Change the numbering on footnotes to the A, B, C format. Here is an example of what one of your footnotes should look like:

7.	 Change the numbering on endnotes to the a, b, c format. Your endnotes should look like this:

8.	 Save a copy of the file with the name, Weather Footnotes and Endnotes.

Reference:
LearnKey’s Word 2016 Training, Session 4: 

Create and Manage References: Insert Footnotes; Insert Endnotes; Modify Footnote Properties; Modify Endnote Properties

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 15-20 minutes

Objectives:
4.0 Create and Manage References

4.1 Create and manage reference markers
4.1.1 Insert footnotes and endnotes
4.1.2 Modify footnote and endnote properties
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Working with Citation Sources
Description: 
When creating a document which contains information from outside sources, those sources often need to be cited. A good test for 
whether to cite a source is this: If someone reading the document can ask you, “How do you know this to be true?” then the source of 
your information needs a citation.

Sometimes, you will know your citation sources and can create those at any time and then place them in the document as needed. At 
other times, you will need to create a citation placeholder and then fill it with a citation source once the source information is found. 
Either way, at the completion of this project, you will be able to create and modify citation sources and add sources to documents, 
either directly or through a placeholder.

Steps for Completion:
1.	 From your student folder, open the Weather Report not 

cited document.
2.	 Modify the current citation source to change the Title to, 

When Temperature Freezes, 2nd Edition, the Year of the 
source to 2000, and the Tag name of the source to Jon2000. 
Your citation source should resemble the example on the 
right:

3.	 Create a new citation source, filling the source with the  
information below:

4.	 On page 1 of the document, insert a citation placeholder after the word, Fahrenheit, in the second paragraph of the Relative Humidity 
section.

5.	 On page 3 of the document, insert a citation using the book by Tim Towers as a source at the end of the paragraph under the heading, The 
Warmest Winter States in the East.

6.	 On page 1, edit the source of the placeholder you added earlier to read as follows:

7.	 Save a copy of the file with the name, Weather Report Cited.
8.	 If you are continuing to the next project, leave this file open.

Reference:
LearnKey’s Word 2016 Training, Session 4: 

Create and Manage References: Create Bibliography Citation Sources; Modify Bibliography Citation Sources; Insert Citations for Bibliographies

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
4.0 Create and Manage References

4.1 Create and manage reference markers
4.1.3 Create bibliography citation sources
4.1.4 Modify bibliography citation sources
4.1.5 Insert citations for bibliographies
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Working with Figure and Table Captions
Description: 
Captions are descriptions which can be added to pictures, tables, charts, and other objects. When adding captions, the caption label 
and its position relative to the object it is describing are key factors to consider. While Word has built-in caption labels, custom labels 
can be created.

After completing this project, you will have a better understanding of how captions are created, used, and customized. You will also 
know how to generate a table of figures.

Steps for Completion:
1.	 From your student folder, open the Aquarium document.
2.	 Insert a caption on the first picture, labeling it Picture 1 and using the text, Skate Fish.
3.	 Insert a caption on the second picture, labeling it Picture 2 and using the text, Cretaceous Fish.
4.	 Insert a caption on the table, labeling it Table 1 and using the text, Seasonal Exhibits, making sure the caption is placed below the table.
5.	 Insert a caption on the hours pyramid, labeling it Figure 1 and using the text, Hours of Operation.
6.	 Delete the text, And, here are our hours of operation:
7.	 Move to page 2 of the document (insert a page break if needed).
8.	 At the top of page 2, add the text, Table of Pictures, and press the Enter key.
9.	 Insert a table of figures for the two pictures on which you placed captions earlier.
10.	 Save a copy of the file with the name, Aquarium with Captions.

Reference:
LearnKey’s Word 2016 Training, Session 4: 

Create and Manage References: Insert Figure Captions; Insert Table Captions; Modify Caption Properties

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
4.0 Create and Manage References

4.1 Create and manage reference markers
4.1.6 Insert figure and table captions
4.1.7 Modify caption properties
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Table of Contents and Cover Pages
Description: 
Many documents become large enough to where a table of contents is warranted, usually at or near the beginning of a document. A 
table of contents can be created manually, but is much easier to create when it is automatically generated using styles (usually heading 
styles). An additional benefit to automatically generating a table of contents is that it can be easily updated as its entries (again, usually 
headings) change.

In addition to adding a table of contents to a document, a cover page can also add a nice finishing touch to a document. Upon comple-
tion of this project, you will be familiar with inserting a table of contents, updating a table of contents, and adding a cover page to a 
document.

Steps for Completion:
1.	 From your student folder, open the Animal Farm document.
2.	 Click on the House Pets heading. Notice that the applied style is the Heading 1 style.
3.	 Click on the Zoo Animals heading on page 2. Again, notice that the applied style is the Heading 1 style.
4.	 Insert a page break before the House Pets heading on page 1.
5.	 Return the cursor to page 1.
6.	 Insert a table of contents, using the built-in Automatic Table 2 style.
7.	 Insert a cover page, using the Ion (Dark) option.
8.	 Scroll down to the last page of the document.
9.	 Delete the More Information heading and the sentence below it.
10.	 Change the heading with the text, Adding Animal Pictures to Documents to the text, Inserting Animal Pictures in Documents.
11.	 Update the table of contents. Your table of contents should look like this:

12.	 Save a copy of the file with the name, Animal Farm_Final.
13.	 Close all open files.

Reference:
LearnKey’s Word 2016 Training, Session 4: 

Create and Manage Simple References: Insert a Table of Contents; Update a Table of Contents; Insert a Cover Page

Difficulty: Advanced 

Required Materials: Word 2016 

Estimated Time to Complete: 15 minutes

Objectives:
4.0 Create and Manage References

4.2 Create and manage simple references
4.2.1 Insert a standard table of contents
4.2.2 Update a table of contents
4.2.3 Insert a cover page
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Session 5
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Session 5 Fill-in-the-Blanks
Instructions: While watching Session 5, fill in the missing words according to the information presented by the 
instructor. [References are found in the brackets.]

Insert and Format Graphic Elements

1.	 Word 2016 is not only a  editor. [Insert Graphic Elements]

2.	 Shapes are often used in Word documents for  effect. [Insert Shapes]

3.	  are often used when you wish to leave a comment. [Insert Shapes]

4.	 By default, adding a picture to a Word document will affect the  position of a document. [In-
sert Pictures]

5.	 You can add  or partial screenshots to Word documents. [Insert Screenshots]

6.	 When you insert a screen clipping, Word 2016 will take a clip of the last  you used that was 
not Word 2016. [Insert Screen Clippings]

7.	 Text boxes are often used in Word 2016 to  text. [Insert Text Boxes]

Format Graphic Elements

8.	 With shapes and text boxes, you can modify the  , color, and text color. [Apply Artistic Effects]

9.	 When you select a picture, a  tab will appear. [Apply Artistic Effects]

10.	 You can lock the  of a picture in the Size dialog box launcher. [Apply Picture Effects]

11.	 Under the Format tab, you can alter the brightness of a picture by clicking  . [Apply Picture Ef-
fects]

12.	 Word 2016 is not a photo  program. [Remove Picture Backgrounds]

13.	 You can add shape  to a shape to add contrast to your document. [Format Objects]
14.	 The type of shape you have added to a document can be changed under the Format tab by clicking 

 . [Format Objects]

15.	 You can select more than one shape in a document by holding the  while you select shapes. 
[Format Objects]

16.	 Picture styles can be added to a picture under the Format tab by clicking  . [Apply Picture Styles]

17.	 The  wrap text format means Word 2016 thinks a picture is one single character. [Wrap Text 
Around Objects]

18.	 The default wrap text format for text boxes is  . [Wrap Text Around Objects]

19.	 When you move objects on a document, you may want to consider the  position of the objects. 
[Position Objects]

20.	 If a document is going to be published as a  , you may want to add alternative text to your 
objects. [Add Alternative Text to Objects]

Insert and Format SmartArt Graphics

21.	 SmartArt is a Word 2016 feature that takes care of the  work for you. [Create a SmartArt Graphic]

22.	 SmartArt is essentially a  of graphics. [Create a SmartArt Graphic]

23.	 All, List, Process, Cycle, Hierarchy, Relationship, Matrix,  , Picture, and Office.com are Smart-
Art Graphics in Word 2016. [Create a SmartArt Graphic]

24.	 SmartArt graphic tabs include  and Format. [Format a SmartArt Graphic]
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25.	 When you are working with SmartArt graphics, it is important to pay attention to the selection 

. [Modify SmartArt Graphic Content]
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Inserting Shapes and Pictures
Description: 
Not every Word document is merely a technical document, report, or list. Many Word documents can be set up as newsletters, bro-
chures, flyers, or advertisements. One way to make information stand out is to add shapes and text inside of those shapes. Another 
option is to add one or more pictures to a document.

Making shapes and pictures work perfectly with text in Word documents is a concept covered in a future project. Upon completing 
this project, you will know how to add shapes to a document, fill the shapes with text, and add pictures to a document.

Steps for Completion:
1.	 From your student folder, open the National Park Trip document.
2.	 Place the cursor just below the Bryce Canyon National Park heading, in front of the first paragraph under the heading.
3.	 Insert the Bryce_Canyon.png picture.
4.	 Place the cursor below the, Here is one character you probably will not see at this or any other national park, sentence.
5.	 Insert the Odd_Man.png picture.
6.	 Place your cursor at the end of the document.
7.	 Insert a rectangular shape, approximately 1.5 inches wide by 1 inch tall.
8.	 In the rectangular shape, add the text, Plan how to get there.
9.	 To the right of the rectangular shape, add a rounded rectangle, approximately 1.5 inches wide by 1 inch tall.
10.	 In the rounded rectangle, add the text, Make your reservations.
11.	 To the right of the rounded rectangle, add a round shape (circle or ellipse of your choice), making it about 1.5 inches wide and tall.
12.	 In the round shape, add the text, Check the weather before you go. Your shapes should look similar to this:

13.	 Save a copy of the file with the name, National Park Trip Shapes.

Reference:
LearnKey’s Word 2016 Training, Session 5: 

Insert and Format Graphic Elements: Insert Shapes; Insert Pictures

Difficulty: Beginner Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 15-20 minutes

Objectives:
5.0 Insert and Format Graphic Elements

5.1 Insert graphic elements
5.1.1 Insert shapes
5.1.2 Insert pictures
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Screenshots, Screen Clippings, and Text Boxes
Description: 
Many Word documents can be technical in nature and be built to show people how to do something, such as work with a computer 
program or navigate through a website. To aid in this, screenshots and screen clippings, which are partial screenshots, can be added to 
a document. Furthermore, text boxes can be added to a document. The benefit of a text box is that it can be placed anywhere on a page 
and thus is not subject to the existing flow of text on a page. After completing this project, you will have a better understanding of how 
to add text boxes, screenshots, and screen clippings to a Word document.

Steps for Completion:
1.	 Open a web browser other than Microsoft Edge as Microsoft Edge is not consistent in supporting screenshots from Microsoft Office.
2.	 Navigate to www.learnkey.com.
3.	 From your student folder, open the Education 

Opportunities document.
4.	 Select the text, (Insert LK website screen here), near the 

top of the document.
5.	 Insert a screenshot of the LearnKey website. It will 

replace the selected text.
6.	 In your web browser, navigate to www.gmetrix.net.
7.	 In your document, select the text, (Insert GMetrix logo 

here).
8.	 Insert a screen clipping of the GMetrix logo. It will 

replace the selected text.
9.	 Make sure the subsequent text is on its own line.
10.	 In your web browser, navigate to www.certiport.com.
11.	 In your document, select the text, (Insert Certiport logo 

here).
12.	 Insert a screen clipping of the Certiport logo. It will  

replace the selected text. 
13.	 Place the cursor below the existing items on the page.
14.	 Insert an Austin Quote text box.
15.	 Replace the placeholder text with the text, Three great 

ways to learn! Your document should look  
similar to the example on the right:

16.	 Save a copy of this file with the name, Education  
Opportunities_Completed.

Reference:
LearnKey’s Word 2016 Training, Session 5: 

Insert and Format Graphic Elements: Insert Screenshots; 
Insert Screen Clippings; Insert Text Boxes

Difficulty: Intermediate 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
5.0 Insert and Format Graphic Elements

5.1 Insert graphic elements
5.1.3 Insert a screenshot or screen clipping
5.1.4 Insert text boxes

http://www.learnkey.com
http://www.gmetrix.net
http://www.ceriport.com
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Applying Picture Effects and Styles
Description: 
Though Word is not Photoshop, many types of adjustments can be made to pictures. Pictures can have artistic or other types of effects 
added. Unwanted backgrounds can be trimmed from pictures. And to best frame the picture, a picture style can be applied.

Upon completing this project, you will have a better understanding of the types of artistic effects and other types of effects which can 
be placed on a picture. You will also have a better understanding of removing the background area from a picture and adding a style to 
a picture.

Steps for Completion:
1.	 From your student folder, open the National Park Trip Food document.
2.	 Select the picture of the canyon.
3.	 Apply the Crisscross Etching artistic effect to the picture.
4.	 Select the picture of the man on page 2 of the document.
5.	 Apply the Brightness +20%/Contrast -40% correction to the picture.
6.	 Apply the Orange Accent color 6 Dark color effect to the picture.
7.	 Select the picture of the Brussels sprouts on page 3 of the document.
8.	 Use the Remove Background feature to remove most of the shadows of the Brussels sprouts. [Note to teachers: Reducing the size of the 

selection box to cover just the Brussels sprouts will accomplish this.]
9.	 Apply the Metal Frame style to the picture of the Brussels sprouts. The picture of the Brussels sprouts should resemble this:

10.	 Save a copy of the file with the name, National Park Trip Pictures.

Reference:
LearnKey’s Word 2016 Training, Session 5: 

Format Graphic Elements: Apply Artistic Effects; Apply Picture Effects; Remove Picture Backgrounds; Apply Picture Styles

Difficulty: Advanced 

Required Materials: Word 2016 

Estimated Time to Complete: 10-15 minutes

Objectives:
5.0 Insert and Format Graphic Elements

5.2 Format graphic elements
5.2.1 Apply artistic effects
5.2.2 Apply picture effects
5.2.3 Remove picture backgrounds
5.2.5 Apply a picture style
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Formatting and Positioning Objects
Description: 
Once objects, such as shapes, pictures, and text boxes are added to documents, the next step is to make the objects work well with the 
existing text in the document. This involves formatting objects to change colors, lines, and text formats. One particular aspect of for-
matting objects is positioning them in visually appealing spots on a page and, when necessary, wrapping text around these objects. 

In addition, alternative text should be added to these objects so that those who use voice readers and similar devices to listen to Word 
documents rather than read them can gain insight as to what an object represents, even if they cannot see the objects. After completing 
this project, you will be well-versed in formatting objects, wrapping text around objects, positioning objects, and adding alternative text 
to objects.

Steps for Completion:
1.	 From your student folder, open the National Park Trip Draft document.
2.	 Select the shape on page 3 with the text, Plan how to get there.
3.	 Apply the Colored Fill – Orange, Accent 6 style to the shape.
4.	 Select the shape on page 3 with the text, Make your reservations.
5.	 Change the shape fill to Red, Accent 2, Darker 25%.
6.	 Change the outline color to Red, Accent 2, Lighter 40%.
7.	 Select the shape on page 3 with the text, Check the weather before you go.
8.	 Change the shape to an eight-point star.
9.	 Add an Offset Diagonal Bottom Right shadow to the star.
10.	 Select the text box near the bottom on page 3.
11.	 Apply the Gradient Fill – Accent 4, No Outline shape style to the text box.
12.	 Scroll back up to page 1.
13.	 Select the picture of the canyon.
14.	 Change the width of the picture to 2.5 inches, 

making sure while doing so the height changes 
proportionally.

15.	 Turn on the Square text wrapping option for the 
picture.

16.	 Move the picture to the right side of the page, 
making sure to not exceed the margin on the right 
side of the page. The top of your document should 
resemble the example on the right:

17.	 Add the text, Bryce Canyon, as the title for 
alternative text to the picture.

18.	 Scroll down and select the table at the end of the 
document.

19.	 Add the text, List of National Parks, as the title for 
alternative text to the table.

20.	 Save a copy of the document with the name, 
National Park Trip Draft_Complete.

Reference:
LearnKey’s Word 2016 Training, Session 5: 

Format Graphic Elements: Format Objects; Wrap Text Around Objects; Position Objects; Add Alternative Text to Objects

Difficulty: Advanced 

Required Materials: Word 2016 

Estimated Time to Complete: 15-20 minutes

Objectives:
5.0 Insert and Format Graphic Elements

5.2 Format graphic elements
5.2.4 Format objects
5.2.6 Wrap text around objects
5.2.7 Position objects
5.2.8 Add alternative text to objects for accessibility
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Inserting and Formatting SmartArt Graphics
Description: 
A long Word document with nothing but headings and paragraphs can become difficult to read after a while. Occasionally, a graphic 
with bullet points of text used to explain a concept can pique one’s interest in a document.

To accomplish this, we have SmartArt, which is a graphic representation of text. After completing this project, you will know how to 
add a SmartArt graphic, add and modify content, and format a SmartArt graphic.

Steps for Completion:
1.	 From your student folder, open the Marketing Plan Revised document.
2.	 Scroll down to the Target Market section on page 2.
3.	 Erase the text in the Target Market section.
4.	 Make sure there are two blank lines in between the Target Market section and the Message Summary section.
5.	 Insert a Vertical Bullet List SmartArt graphic into the Target Market section.
6.	 Fill out the SmartArt graphic to resemble the text you see below:

7.	 Change the SmartArt graphic to a Tab List format.
8.	 Add a third main point to the SmartArt graphic with the text, Shelf Life.
9.	 To the new main point, add the subpoint, How long will the product be viable?
10.	 Apply the Subtle Effect SmartArt style to the SmartArt graphic.
11.	 Change the color scheme of the SmartArt graphic to Colored Fill – Accent 2.
12.	 Change the fill color of the Shelf Life shape to Gold, Accent 4, Lighter 80%.
13.	 Save a copy of the file with the name, Marketing Plan Revised_Complete.

Reference:
LearnKey’s Word 2016 Training, Session 5: 

Insert and Format SmartArt Graphics: Create a SmartArt Graphic; Format a SmartArt Graphic; Modify SmartArt Graphic Content

Difficulty: Advanced 

Required Materials: Word 2016 

Estimated Time to Complete: 15 minutes

Objectives:
5.0 Insert and Format Graphic Elements

5.3 Insert and format SmartArt graphics
5.3.1 Create a SmartArt graphic
5.3.2 Format a SmartArt graphic
5.3.3 Modify SmartArt graphic content
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Word 2016 Master Project
Description:
Now that you have learned all of the appropriate skills required to create a professional document using Word 2016, it is time to 
put your skills to use. Beginning with the basics, you will have the opportunity to design a document which enlists many of the 
elements you have learned about throughout the training. This project will help you to put your new skills into action by creating an 
informational flyer. Have fun!

This master project is divided into four parts and is designed to implement the majority of the skills acquired during this course. In 
Part 1, you will import and format the text for the body of your flyer. In Part 2, you will create a table converted from text. In Part 3, 
you will create a numbered list as well as a bulleted list with columns. Then in Part 4, you will create and format a bibliography with 
citations. The flyer will provide information about the International Space Station to prospective space travelers as well as a detailed 
description regarding typical daily activities aboard the space station.

Part 1
Description:
For this project, you will use the knowledge you have gained to design and create a flyer which will provide information about the 
International Space Station. 

Steps for Completion:
1.	 Open a blank document or choose a template to use as the flyer. Import the AstronautMainText_start file. Convert any web addresses to 

hyperlinks with descriptive display text.
2.	 Insert the text, Introduction to the International Space Station, as a header at the top of the page. Insert page numbers at the bottom of 

each page. Adjust the line spacing to 1.0.
3.	 Change the font of the text to Arial. Change the font size of the paragraph headings to 14. Add the Heading 2 style heading and then use 

the Format Painter to apply it to the other paragraph headings. Convert the page title to WordArt.
4.	 Insert the SpaceShuttle_start and globe_start files into your document. Apply picture effects to the SpaceShuttle_start picture. Modify the 

shape of the globe_start picture. Wrap the text around the globe_start picture.

Part 2
Description:
Tables are used to display information in an organized way. In this part, you will create a table outlining the typical schedule of an 
astronaut aboard the International Space Station.

Steps for Completion:
1.	 Insert a page break after the main text. Change the orientation of the next page to landscape. 
2.	 Open the AstronautSchedule_start file and copy and paste the contents onto the page. Select the daily activities list and descriptions and 

convert the text to a table with nine columns. AutoFit the table contents.
3.	 Insert a row above the table. Merge the cells in this row and give the table the title, An Astronaut’s Daily Schedule. Center this title. 

Apply a table style to the table.
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Required Materials: Word 2016

Part 3
Description:
Lists are used to display several items on a page. Numbered lists are used to list items which have specific order associated with them. 
Bulleted lists are used when order is not important. In this part of the project, you will create a numbered list and a bulleted list with 
columns.

Steps for Completion:
1.	 Insert a page break after the table. Change the orientation of the next page to portrait. 
2.	 Open the AstronautLists_start file and copy and paste the contents onto the page. Select the astronaut prerequisites and make them into 

a numbered list. Under the Items I would bring on a long spaceflight section, create a bulleted list of 10 items that you would bring with 
you on your trip. Divide the list into two columns with five bullets in each column.

Part 4
Description:
Now it’s time to cite your sources. After creating a great document full of wonderful information, it is important to make sure that you 
give credit to the sources which contain the information. In this part, you will create a bibliography citing your sources.

Steps for Completion:
1.	 Insert a page break after the lists.
2.	 Open the AstronautCitations_start file and use the citations to create a bibliography for your document.
3.	 Take several screenshots of your document while using a split window, zoom, web layout view, and full screen views. Save the document as 

a PDF.
4.	 Submit your finished document and screenshots to your instructor.



Appendix



Lesson Topic Subtopic Objectives Activity Notes
Lesson 1 Session 1 Pre-Assessment

Lesson 2 Introduction 
to Word 2016

Introduction Watch Session 1: Intro-
duction to Word 2016 [1 
minute]

Lesson 2 
(Continued)

Getting 
Started

How to Take This    
   Course
Tour of Office
Tour of Word

Watch Session 1: Getting 
Started [15 minute]

Discuss Microsoft Office 
and the Word interface

Lesson 3 Create 
Documents

Create a Blank Docu-
   ment
Create a Document 
   from a Template
Open a PDF in Word
Insert Text from Other 
   Sources

1.0 Create and Manage Documents
1.1 Create a document

1.1.a Create a blank document
1.1.b Create a blank document using a 
template
1.1.c Open a PDF in Word for editing
1.1.d Insert text from a file or external 
source

Watch Session 1: Create 
Documents [17 minutes]

Fill-in-the-Blanks Session 
1: Questions 

Session 1 Lab 1: Create a 
New Document

Session 1 Lab 2: Template 
Document

Session 1 Lab 3: PDF Files 
in Word 2016

Session 1 Lab 4: External 
Source

Lesson 4 Create 
Documents

See Lesson 3 See Lesson 3 Session 1 Project 1: Work-
ing with Templates

Discuss creating documents

Lesson 5 Navigate 
Through 
Documents

Search for Text
Insert Hyperlinks
Create Bookmarks
The Go To Feature

1.0 Create and Manage Documents
1.2 Navigate through a document

1.2.a Search for text
1.2.b Insert hyperlinks
1.2.c Create bookmarks
1.2.d Move to a specific location or object in 
a document

Watch Session 1: Navigate 
Through Documents [10 
minutes]

Fill-in-the-Blanks Session 
1: Questions 

Session 1 Lab 5: Advanced 
Search

Session 1 Lab 6: Create a 
Hyperlink

Session 1 [Approximately 8.5 hours]

Word 2016 Lesson Plans
Each lesson plan is approximately 30 minutes and includes video training, fill-in-the-blanks, labs, projects, tests, as well as the course support files to follow along with the expert. There is also a note 
section for customizable lesson plans and extra notes. By adhering to the lesson plan, it will take approximately four weeks to complete the course, approximately 22 hours of time training with an 
additional 6-14 hours if the Master Level lesson plans are also completed.



Lesson Topic Subtopic Objective Activity Notes
Lesson 6 Navigate 

Through 
Documents

See Lesson 3 and 5 See Lesson 3 and 5 Session 1 Lab 7: Create a 
Bookmark

Session 1 Lab 8: Using Go 
To

Session 1 Project 2: Import-
ing PDFs

Session 7 Format 
Documents

Modify Page Setup
Apply Document 
   Themes
Apply Document Style 
   Sets
Insert Headers and    
   Footers
Insert Page Numbers
Format Page Back-
   ground Elements
Watermarks

1.0 Create and Manage Documents
1.3 Format a Document

1.3.a Modify page setup
1.3.b Apply document themes
1.3.c Apply document style sets
1.3.d Insert headers and footers
1.3.e Insert page numbers
1.3.f Format page background elements

Watch Session 1: Format 
Documents [29 minutes]

Fill-in-the-Blanks Session 
1: Questions 

Session 8 Format 
Documents

See Lesson 7 See Lesson 7 Session 1 Lab 9: Apply 
Document Themes

Session 1 Lab 10: Apply a 
Style Set

Session 1 Lab 11: Insert a 
Header

Session 1 Lab 12: Add 
Information to a Footer

Session 1 Lab 13: Inserting 
Page Numbers

Session 1 Lab 14: Add a 
Watermark

Session 9 Format 
Documents

See Lesson 7 See Lesson 7 Session 1 Project 3: 
Navigating and Styling a 
Document

Session 1 Project 4: Page 
Setup and Background 
Elements

Lesson 10 Format 
Documents

See Lesson 7 See Lesson 7 Session 1 Project 5: Insert-
ing Headers, Footers, and 
Page Numbers



Lesson Topic Subtopic Objective Activity Notes
Lesson 11 Customize 

Document 
Views and 
Options

Change Document 
   Views
Customize Through 
   Zoom Settings
Customize the Quick 
   Access Toolbar
Split Windows
Add Document Proper-
   ties
Show and Hide Format-
   ting Symbols

1.0 Customize Options and Views for Documents
1.4 Format a Document

1.4.a Change document views
1.4.b Customize views by using zoom set-
tings
1.4.c Customize the Quick Access toolbar
1.4.d Split the window
1.4.e Add document properties
1.4.f Show or hide formatting symbols

Watch Session 1: Custom-
ize Document Views and 
Options [26 minutes]

Fill-in-the-Blanks Session 
1: Questions 

Lesson 12 Customize 
Document 
Views and 
Options

See Lesson 11 See Lesson 11 Session 1 Lab 15: Quick 
Access Customization

Session 1 Lab 16: Docu-
ment Properties

Session 1 Lab 17: Adding a 
Custom Property

Session 1 Lab 18: Control-
ling which Formatting 
Marks Show

Session 1 Project 6: Using 
Different Document Views

Lesson 13 See Lessons 2, 3, 5, and 
11

See Lessons 2, 3, 5, and 11 Session 1 Project 7: Creat-
ing a Word Project

Lesson 14 Print and 
Save Docu-
ments

Modify Print Settings
Save Documents in 
   Different Formats
Print Documents
Check for Document 
   Issues
Inspect for Accessibility 
   Issues
Inspect for 
   Compatibility Issues

1.0 Customize Options and Views for Documents
1.5 Print and Save Documents

1.5.a Modify print settings
1.5.b Save documents in alternative file 
formats
1.5.c Print all or part of a document
1.5.d Inspect a document for hidden prop-
erties or personal information
1.5.e Inspect a document for accessibility 
issues
1.5.f Inspect a document for compatibility 
issues

Watch Session 1: Print 
and Save Documents [22 
minutes]

Fill-in-the-Blanks Session 
1: Questions 24-25

Session 1 Lab 19: Create a 
PDF

Session 1 Lab 20: Inspec-
tion

Lesson 15 Print and 
Save Docu-
ments

See Lesson 14 See Lesson 14 Session 1 Project 8: Printing 
and Saving Documents

Session 1 Project 9: Inspect-
ing a Document



Lesson Topic Subtopic Objective Activity Notes
Lesson 16 Domain 1 

Recap
Domain 1 Test Tips Watch Session 1: Domain 

1 Recap

Review and discuss Word 
2016 Session 1

Lesson 17 Word 2016 Session 1 Post 
Assessment

Session 1 Notes



Lesson Topic Subtopic Objectives Activity Notes

Lesson 1 Session 2 Pre-Assessment

Lesson 2 Insert Text 
and Para-
graphs

Find and Replace Text
Cut and Paste Text
Copy and Paste Text
Use AutoCorrect to 
   Replace Text
Insert Symbols
Insert Special Charac-
   ters
Use Undo and Redo

2.0 Format Text, Paragraphs, and Sections
2.1 Insert Text and Paragraphs

2.1.a Find and replace text
2.1.b Cut, copy and paste text
2.1.c Replace text by using AutoCorrect
2.1.d Insert special characters

Watch Session 2: Insert 
Text and Paragraphs:  [22 
minutes]

Fill-in-the-Blanks Session 
2: Questions 1-12

Session 2 Lab 1: Replace 
Text

Session 2 Lab 2: Cut Text

Lesson 3 Insert Text 
and Para-
graphs

See Lesson 2 See Lesson 2 Session 2 Lab 3: Copy Text

Session 2 Lab 4: Inserting 
Symbols

Session 2 Project 1: Insert-
ing Text and Paragraphs

Lesson 4 Format Text 
and Para-
graphs

Apply Font Formatting
Use the Format Painter
Set Line and Paragraph 
   Spacing
Set Line and Paragraph 
   Indentation
Set Tabs

2.0 Format Text, Paragraphs, and Sections
2.2 Format Text and Paragraphs

2.2.a Apply font formatting
2.2.b Apply formatting by using Format 
Painter
2.2.c Set line and paragraph spacing and 
indentation

Watch Session 2: Format 
Text and Paragraphs: Apply 
Font Formatting- Set Tabs 
[22 minutes]

Fill-in-the-Blanks Session 
2: Questions 1-12

Lesson 5 Format 
Text and 
Paragraphs 
(Continued)

Clear Formatting
Use the Text High-
   lighter
Apply Built-In Styles
Change Text to  
   WordArt

2.0 Format Text, Paragraphs, and Sections
2.2 Format Text and Paragraphs

2.2.d Clear formatting
2.2.e Apply a text highlight color to text 
selections
2.2.f Apply built-in styles to text
2.2.g Change text to WordArt

Watch Session 2: Format 
Text and Paragraphs: Clear 
Formatting- Change Text to 
WordArt [10 minutes]

Fill-in-the-Blanks Session 
2: Questions 1-12

Session 2 Lab 5: Formatting 
Text

Session 2 Lab 6: Line 
Spacing

Session 2 Lab 7: Paragraph 
Spacing

Session 2 Lab 8: Paragraph 
and Line Spacing

Session 2 [Approximately 6 hours]



Lesson Topic Subtopic Objective Activity Notes
Lesson 6 Format Text 

and Para-
graphs

See Lesson 4 and 5 See Lesson 4 and 5 Session 2 Lab 9: Altering 
Indentation

Session 2 Lab 10: Set a Tab

Session 2 Lab 11: Apply a 
Style

Session 2 Lab 12: Apply 
WordArt

Lesson 7 Format Text 
and Para-
graphs

See Lesson 4 and 5 See Lesson 4 and 5 Session 2 Project 2: Format-
ting Text and Paragraphs

Lesson 8 Format Text 
and Para-
graphs

See Lesson 4 and 5 See Lesson 4 and 5 Session 2 Project 3: High-
lights, Styles, and WordArt

Discuss formatting texta nd 
paragraphs

Lesson 9 Order and 
Group Text 
and Para-
graphs

Format Text in Multiple 
   Columns
Insert Page Breaks
Insert Section Breaks
Insert Column Breaks
Set Page Setup Options 
   in a Section

2.0 Format Text, Paragraphs, and Sections
2.3 Order and Group Text and Paragraphs

2.3.a Format text in multiple columns
2.3.b Insert page, section, or column breaks
2.3.c Change page setup options for a section

Watch Session 2: Order and 
Group Text and Paragraphs 
[19 minutes]

Fill-in-the-Blanks Session 
2: Questions 22-25

Session 2 Lab 13: Format-
ting Columns

Session 2 Lab 14: Insert a 
Page Break

Session 2 Lab 15: Section 
Page Setup Options

Lesson 10 Order and 
Group Text 
and Para-
graphs

See Lesson 9 See Lesson 9 Session 2 Project 4: Order-
ing and Grouping Text 
Paragraphs

Lesson 11 Domain 2 
Recap

Domain 2 Test Tips Watch Session 2: Domain 2 
Recaps [3 minutes]

Review and discuss Word 
2016 Session 2



Lesson Topic Subtopic Objective Activity Notes
Lesson 12 Word 2016 Session 2 Post 

Test

Session 2 Notes



Lesson Topic Subtopic Objectives Activity Notes
Lesson 1 Session 3 Pre-Assessment

Lesson 2 Create Tables 
and Lists

Create a Table
Convert Text to Tables
Convert Tables to Text
Create a Table with 
   Specific Options
Apply Table Styles
Set Table Style Options

3.0 Create Tables and Lists
3.1 Create a Table

3.1.a Convert text to tables
3.1.b Convert tables to text
3.1.c Create a table by specifying rows and 
columns
3.1.d Apply table styles

Watch Session 3: Cre-
ate Tables and Lists[23 
minutes]

Fill-in-the-Blank Session 
3: Questions 1-5

Session 3 Lab 1: Text to 
Table

Session 3 Lab 2: Tables 
to Text

Lesson 3 Create Tables 
and Lists

See Lesson 2 See Lesson 2 Session 3 Lab3: Table 
from Scratch

Session 3 Lab 4: Apply 
Style

Session 3 Lab 5: Build a 
Style

Session 3 Project 1: Con-
verting Text to Tables and 
Tables to Text

Lesson 4 Create Tables 
and Lists

See Lesson 2 See Lesson 2 Session 3 Project 2: Creat-
ing and Styling Tables

Discuss creating tables 
and lists

Lesson 5 Modify a 
Table

Sort Table Data
Cell Margins and Spac-
   ing
Merge and Split Cells
Resize Tables
Resize Rows and Col-
   umns
Split Tables
Configure a Repeating 
   Row Header

3.0 Create Tables and Lists
3.2 Modify a Table

3.2.a Sort table data
3.2.b Configure cell margins and spacing
3.2.c Merge and split cells 
3.2.d Resize tables, rows, and columns
3.2.e Split tables
3.2.f Configure a repeating row header

Watch Session 3: Shapes 
and Images [23 minutes]

Fill-in-the-Blank Session 
3: Questions 8-14

Session 3 Lab 6: Sort 
Table Content

Session 3 Lab 7: Increase 
Cell Spacing

Session 3 Lab 8: Merge 
Cells

Lesson 6 Modify a 
Table

See Lesson 5 See Lesson 5 Session 3 Lab 9: Split 
Cells

Session 3 Lab 10: Add a 
Repeating Row

Session 3 Project 3: 
Sorting Information and 
Formatting Table Cells

Session 3  [Approximately 6.5 hours]



Lesson Topic Subtopic Objective Activity Notes
Lesson 7 Modify a 

Table
See Lesson 5 See Lesson 5 Session 3 Project 4: Modi-

fying Tables

Discuss modifying tables

Lesson 8 Create and 
Modify a List

Create a Numbered List
Create a Bulleted List
Change Number For-
   mats
Change Bullet Char-
   acters
Customize Bullet Char-
   acters
Customize Number 
   Formats
Increase or Decrease 
   List Levels
Control List Numbering
Set Starting Number 
   Value

3.0 Create and Modify a List
3.3 Modify a Table

3.3.a Create a numbered or bulleted list
3.3.b Change bullet characters or number 
formats for a list level
3.3.c Define a custom bullet character or 
number format
3.3.d Increase or decrease list levels
3.3.e Restart or continue list numbering
3.3.f Set starting number value

Watch Session 3: Create 
and Modify a List [20 
minutes]

Fill-in-the-Blanks Session 
3: Questions 19-23

Session 3 Lab 11: Create a 
Numbered List

Session 3 Lab 12: Change 
Bullet Characters

Session 3 Lab 13: Define a 
Bullet Character

Lesson 9 Create and 
Modify a List

See Lesson 8 See Lesson 8 Session 3 Lab 14: Create a 
Number Format

Session 3 Lab 15: List 
Numbering

Session 3 Lab 16: Restart 
Bullet Numbering

Session 3 Project 5: 
Creating and Modifying 
Bullieted Lists

Lesson 10 Create and 
Modify a List

See Lesson 8 See Lesson 8 Session 3 Project 6: 
Creating and Modifying 
Numbered Lists

Lesson 11 Domain 3 
Recap

Domain 3 Test Tips Watch Session 3: Domain 
3 Recap [2 minutes]

Review and discuss Word 
2016 Session 3



Lesson Topic Subtopic Objective Activity Notes
Lesson 13 Word 2016 Session 3 Post 

Assessment

Session 3 Notes



Lesson Topic Subtopic Objectives Activity Notes

Lesson 1 Session 4 Pre-Assessment

Lesson 2 Create and 
Manage Ref-
erences

Create and Manage 
   Reference Markers
Insert Footnotes
Insert Endnotes
Modify Footnote Prop-
   erties
Modify Endnote Prop-
   erties
Create Bibliography 
   Citation Sources
Modify Bibliography 
   Citation Sources
Insert Citations for 
   Bibliographies
Insert Figure Captions
Insert Table Captions
Modify Caption Proper-
   ties

4.0 Create and Manage References
4.1 Create and Manage Reference Markers

4.1.a Insert footnotes and endnotes
4.1.b Modify footnote and endnote properties
4.1.c Create bibliography citation sources
4.1.d Modify bibliography citation sources
4.1.e Insert citations for bibliographies
4.1.f Insert figure and table captions
4.1.g Modify caption properties

Watch Session 4: Create 
and Manage References [29 
minutes]

Fill-in-the-Blanks Session 
4: Questions 1-12

Lesson 3 Create and 
Manage Ref-
erences

See Lesson 2 See Lesson 2 Session 4 Lab 1: Inserting a 
Footnote

Session 4 Lab 2: Inserting 
an Endnote

Session 4 Lab 3: Changing 
Footnote Location

Session 4 Lab 4: Changing 
Endnote Numbering

Session 4 Lab 5: Create a 
Book Source

Session 4 Lab 6: Create a 
Web Site Source

Session 4 Lab 7: Editing a 
Source

Session 4 Lab 8: Adding a 
Source to a Document

Session 4 [Approximately 5 hours]



Lesson Topic Subtopic Objective Activity Notes
Lesson 4 Create and 

Manage Ref-
erences

See Lesson 2 See Lesson 2 Session 4 Lab 9: Adding a 
Placeholder

Session 4 Lab 10: Creating 
a New Source Citation

Session 4 Lab 11: Editing a 
Placeholder Source

Session 4 Lab 12: Source 
Verification

Session 4 Lab 13: Editing a 
Placeholder Source

Session 4 Lab 14: Adding a 
Caption to a Table

Session 4 Lab 15: Modify a 
Caption

Session 4 Lab 16: Adding a 
Table of Figures

Lesson 5 Create and 
Manage Ref-
erences

See Lesson 2 See Lesson 2 Session 4 Project 1: Foot-
notes and Endnotes

Lesson 6 Create and 
Manage Ref-
erences

See Lesson 2 See Lesson 2 Session 4 Project 2: Work-
ing with Citation Sources

Session 4 Project 3: Work-
ing with Figure and Table 
Captions

Lesson 7 Create and 
Manage 
Simple Refer-
ences

Insert a Table of Con-
   tents
Update a Table of 
   Contents
Insert a Cover Page

4.0 Create and Manage References
4.2 Create and Manage Simple References

4.2.a Insert a standard table of contents
4.2.b Update a table of contents
4.2.c Insert a cover page

Watch Session 4: Create 
and Manage Simple Refer-
ences [11 minutes]

Fill-in-the-Blanks Session 
4: Questions 1-12

Session 4 Lab 17: Create 
an Automated Table of 
Contents

Session 4 Lab 18: Create a 
Manual Table of Contents

Session 4 Lab 19: Updating 
the Table of Contents

Session 4 Lab 20: Add a 
Cover Page



Lesson Topic Subtopic Objective Activity Notes
Lesson 8 Create and 

Manage 
Simple Refer-
ences

See Lesson 7 See Lesson 7 Session 4 Project 4: Table of 
Contents and Cover Pages

Lesson 9 Proofing the 
Document

Check Spelling and 
Grammar

Watch Session 4: Proofing 
the Document [4 minutes]

Fill-in-the-Blanks Session 
4: Questions 22-25

Lesson 9 
(Continued)

Domain 4 
Recap

Domain 4 Test Tips See Lesson 9 Watch Session 4: Domain 4 
Recap [4 minutes]

Review and discuss Word 
2016 Session 4

Lesson 10 Word 2016 Session 4 Post 
Test

Session 4 Notes



Lesson Topic Subtopic Objectives Activity Notes
Lesson 1 Session 5 Pre-Assessment

Lesson 2 Insert and 
Format 
Graphic Ele-
ments

Insert Graphic Elements
Insert Shapes
Insert Pictures
Insert Screenshots
Insert Screen Clippings
Insert Text Boxes

5.0 Insert and Format Graphic Elements
5.1 Insert Graphic Elements

5.1.a Insert shapes
5.1.b Insert pictures
5.1.c Insert a screen shot or screen clip-
pings
5.1.d Insert text boxes

Watch Session 5: Insert 
and Format Graphic Ele-
ments [12 minutes]

Fill-in-the-Blank Session 
5: Questions 1-5

Session 5 Lab 1: Insert a 
Shape

Session 5 Lab 2: Insert a 
Picture

Session 5 Lab 3: Insert a 
Screenshot

Session 5 Lab 4: Insert a 
Screen Clipping

Session 5 Lab 5: Insert a 
Text Box

Lesson 3 Insert and 
Format 
Graphic Ele-
ments

See Lesson 2 See Lesson 2 Session 5 Project 1: Insert-
ing Shapes and Pictures

Lesson 4 Insert and 
Format 
Graphic Ele-
ments

See Lesson 2 See Lesson 2 Session 5 Project 2: 
Screenshots, Screen Clip-
pings, and Text Boxes

Discuss inserting and for-
matting graphic elements 
and other objects

Lesson 5 Format 
Graphic Ele-
ments

Apply Artistic Effects
Apply Picture Effects
Remove Picture Back-
   grounds
Format Objects
Apply Picture Styles
Wrap Text Around 
   Objects
Position Objects
Add Alternative Text to 
   Objects

5.0 Insert and Format Graphic Elements
5.2 Format Graphic Elements

5.2.a Apply artistic effects
5.2.b Apply picture effects
5.2.c Remove picture backgrounds
5.2.d Format objects
5.2.e Apply a picture style
5.2.f Wrap text around objects
5.2.g Position objects
5.2.h Add alternative text to objects for 
accessibility

Watch Session 5: Insert 
and Format Graphic Ele-
ments [26 minutes]

Fill-in-the-Blank Session 
5: Questions 1-5

Session 5 Lab 6: Apply an 
Artistic Effect

Session 5 Lab 7: Apply a 
Picture Effect

Session 5  [Approximately 6 hours]



Lesson Topic Subtopic Objective Activity Notes
Lesson 6 Format 

Graphic Ele-
ments

See Lesson 5 See Lesson 5 Session 5 Lab 8: Remove a 
Background

Session 5 Lab 9: Shape 
Position

Session 5 Lab 10: Format 
Shapes

Session 5 Lab 11: Group-
ing Shapes

Session 5 Lab 12: Apply a 
Picture Style

Session 5 Lab 13: Wrap 
Text

Lesson 7 Format 
Graphic Ele-
ments

See Lesson 5 See Lesson 5 Session 5 Lab 14: Reposi-
tioning

Session 5 Lab 15: Add 
Alternative Text

Session 5 Lab 16: Adding 
Alternative Text to a Table

Session 5 Project 2: Ap-
plying Picture Effects and 
Styles

Lesson 8 Format 
Graphic Ele-
ments

See Lesson 5 See Lesson 5 Session 5 Project 3: For-
matting and Positioning 
Objects



Lesson Topic Subtopic Objective Activity Notes
Lesson 9 Insert and 

Format 
SmartArt 
Graphics

Create a SmartArt 
   Graphic
Format a SmartArt 
   Graphic
Modify SmartArt 
   Graphic Content

5.0 Insert and Format Graphic Elements
5.3 Insert and Format SmartArt Graphics

5.3.a Create a SmartArt graphic
5.3.b Format a SmartArt graphic
5.3.c Modify SmartArt graphic content

Watch Session 5: Insert 
and Format Graphic Ele-
ments [12 minutes]

Fill-in-the-Blank Session 
5: Questions 1-5

Session 5 Lab 17: Add a 
SmartArt Graphic

Session 5 Lab 18: Adding 
Text to SmartArt

Session 5 Lab 19: Format-
ting SmartArt

Session 5 Lab 20: Moving 
SmartArt Graphics

Lesson 10 Insert and 
Format 
SmartArt 
Graphics

See Lesson 9 See Lesson 9 Session 5 Project 4: 
Inserting and Formatting 
SmartArt Graphics

Lesson 11 Domain 5 
Recap

Domain 5 Test Tips Watch Session 5: Domain 
5 Recap

Lesson 12 Word 2016 Session 5 Post 
Assessment

Session 5 Notes



Lesson Topic Subtopic Objectives Activity Notes
Lesson 1 Entire Course Entire Course All Objectives Word 2016 Master Project

Lesson 2 Entire Course Entire Course All Objectives Word 2016 Master Project

Lesson 3 Entire Course Entire Course All Objectives Word 2016 Master Project

Lesson 4 Entire Course Entire Course All Objectives Word 2016 Master Project

Lesson 5 Entire Course Entire Course All Objectives MasterExam

Lesson 6 Entire Course Entire Course All Objectives MasterExam

Lesson 7 Entire Course Entire Course All Objectives MasterExam

Notes

Master Level Lesson Plans [Approximately 6-14 hours]
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 Introduction to Word 2016
Introduction

Getting Started
How to Take This Course
Tour of Office
Tour of Word

Create Documents
Create a Blank Document
Create a Document from a Template
Open a PDF in Word
Insert Text from Other Sources

Navigate Through Documents
Search for Text
Insert Hyperlinks
Create Bookmarks
The Go To Feature

Format Documents
Modify Page Setup
Apply Document Themes
Apply Document Style Sets
Insert Headers and Footers
Insert Page Numbers
Format Page Background Elements
Watermarks

Customize Document Views and Options
Change Document Views
Customize Through Zoom Settings
Customize the Quick Access Toolbar
Split Windows
Add Document Properties
Show and Hide Formatting Symbols

Print and Save Documents
Modify Print Settings
Save Documents in Different Formats
Print Documents
Check for Document Issues
Inspect for Accessibility Issues
Inspect for Compatibility Issues

Domain 1 Recap
Domain 1 Test Tips

Word 2016 Session 1 Outline
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Insert Text and Paragraphs
Find and Replace Text
Cut and Paste Text
Copy and Paste Text
Use AutoCorrect to Replace Text
Insert Symbols
Insert Special Characters
Use Undo and Redo

Format Text and Paragraphs
Apply Font Formatting
Use the Format Painter
Set Line and Paragraph Spacing
Set Line and Paragraph Indentation
Set Tabs
Clear Formatting
Use the Text Highlighter
Apply Built-In Styles
Change Text to WordArt

Order and Group Text and Paragraphs
Format Text in Multiple Columns
Insert Page Breaks
Insert Section Breaks
Insert Column Breaks
Set Page Setup Options in a Section

Domain 2 Recap
Domain 2 Test Tips

Word 2016 Session 2 Outline
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Create Tables and Lists
Create a Table
Convert Text to Tables
Convert Tables to Text
Create a Table with Specific Options
Apply Table Styles
Set Table Style Options

Modify a Table
Sort Table Data
Cell Margins and Spacing
Merge and Split Cells
Resize Tables
Resize Rows and Columns
Split Tables
Configure a Repeating Row Header

Create and Modify a List
Create a Numbered List
Create a Bulleted List
Change Number Formats
Change Bullet Characters
Customize Bullet Characters
Customize Number Formats
Increase or Decrease List Levels
Control List Numbering
Set Starting Number Value

Domain 3 Recap
Domain 3 Test Tips

Word 2016 Session 3 Outline
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Create and Manage References
Create and Manage Reference Markers
Insert Footnotes
Insert Endnotes
Modify Footnote Properties
Modify Endnote Properties
Create Bibliography Citation Sources
Modify Bibliography Citation Sources
Insert Citations for Bibliographies
Insert Figure Captions
Insert Table Captions
Modify Caption Properties

Create and Manage Simple References
Insert a Table of Contents
Update a Table of Contents
Insert a Cover Page

Proofing the Document
Check Spelling and Grammar

Domain 4 Recap
Domain 4 Test Tips

Word 2016 Session 4 Outline
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Insert and Format Graphic Elements
Insert Graphic Elements
Insert Shapes
Insert Pictures
Insert Screenshots
Insert Screen Clippings
Insert Text Boxes

Format Graphic Elements
Apply Artistic Effects
Apply Picture Effects
Remove Picture Backgrounds
Format Objects
Apply Picture Styles
Wrap Text Around Objects
Position Objects
Add Alternative Text to Objects

Insert and Format SmartArt Graphics
Create a SmartArt Graphic
Format a SmartArt Graphic
Modify SmartArt Graphic Content

Domain 5 Recap
Domain 5 Test Tips

Test Taking Tips
Overall Test Tips

Word 2016 Session 5 Outline
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Shortcut Keys
Command Key Combination

Create new document Ctrl+N
Open Ctrl+O
Close Ctrl+W
Save Ctrl+S
Split document window Alt+Ctrl+S
Print Ctrl+P
Print preview Alt+Ctrl+I
Cancel Esc
Undo Ctrl+Z
Redo or repeat Ctrl+Y
Find Ctrl+F
Go to Ctrl+G
Outline view Alt+Ctrl+O
Draft view Alt+Ctrl+N
Insert footnote Alt+Ctrl+F
Insert endnote Alt+Ctrl+D
Insert hyperlink Ctrl+K
Refresh webpage F9
Delete one character to the left Backspace
Delete one character to the right Delete
Copy Ctrl+C
Cut Ctrl+X
Paste Ctrl+V
Insert field Ctrl+F9
Insert line break Shift+Enter
Insert page break Ctrl+Enter
Insert column break Ctrl+Shift+Enter
Insert em dash Alt+Ctrl+Minus Sign (-)
Insert en dash Ctrl+Minus Sign (-)
Insert copyright symbol Alt+Ctrl+C
Insert registered trademark 
symbol

Alt+Ctrl+R

Insert trademark symbol Alt+Ctrl+T
Insert ellipses Alt+Ctrl+Period (.)
Copy text formatting Ctrl+Shift+C
Apply copied formatting Ctrl+Shift+V
Increase font size Ctrl+Shift+>
Decrease font size Ctrl+Shift+<

Increase font by 1 point Ctrl+]
Decrease font by 1 point Ctrl+[
Open font dialog box Ctrl+D
Change letter case Shift+F3
Format letters as capitals Ctrl+Shift+A
Bold text Ctrl+B
Underline text Ctrl+U

Command Key Combination
Underline words only Ctrl+Shift+W
Double underline text Ctrl+Shift+D
Apply hidden text Ctrl+Shift+H
Italic text Ctrl+I
Format letters as small caps Ctrl+Shift+K
Subscript Ctrl+Equal Sign (=)
Superscript Ctrl+Shift+Plus Sign (+)
Single-space lines Ctrl+1
Double-space lines Ctrl+2
1.5 Line spacing Ctrl+5
Left-align paragraph Ctrl+L
Left-indent paragraph Ctrl+M
Hanging indent Ctrl+T
Reduce hanging indent Ctrl+Shift+T
Remove paragraph formatting Ctrl+Q
Help F1
Move text or graphics F2
Repeat last section F4
Go to (home tab) F5
Next pane F6
Spelling (review tab) F7
Extend selection F8
Update selected fields F9
Show keytips F10
Go to next field F11
Save as F12
Go to beginning of document 
(read mode)

HOME

Go to end of document (read 
mode)

END

Exit read mode Esc
Extend mode F8
Select nearest character F8, Left Arrow or Right Arrow
Increase selection F8 multiple times
Reduce selection Shift+F8
Extend selection one character 
to the right

Shift+Right Arrow

Extend selection one character 
to the left

Shift+Left Arrow

Extend selection to end of word Ctrl+Shift+Right Arrow
Extend selection to beginning 
of word

Ctrl+Shift+Left Arrow

Extend selection to end of line Shift+End

Extend selection to beginning 
of line

Shift+Home
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